
 

 

  

 

Basics of 
Office 365 
Just Text 

ITS (2017) 

Use Ctrl + F to search for key words  

This will help you navigate the 
documment faster.  



 

1 
 

Table of Contents 
How to Use Microsoft Office Word 2016 ..................................................................................................... 6 

File ............................................................................................................................................................. 6 

Home ......................................................................................................................................................... 6 

Clipboard ............................................................................................................................................... 6 

Font ....................................................................................................................................................... 6 

Paragraphs ............................................................................................................................................ 6 

Styles ..................................................................................................................................................... 6 

- Heading 1 .............................................................................................................................................. 6 

- Heading 2 .......................................................................................................................................... 6 

- Heading 3 ...................................................................................................................................... 6 

Editing ................................................................................................................................................... 6 

Insert ......................................................................................................................................................... 7 

Pages ..................................................................................................................................................... 7 

Tables .................................................................................................................................................... 7 

Illustrations ........................................................................................................................................... 7 

Add-ins .................................................................................................................................................. 7 

Media .................................................................................................................................................... 7 

Links ...................................................................................................................................................... 7 

Comments ............................................................................................................................................. 7 

Header & Footer ................................................................................................................................... 7 

Text ....................................................................................................................................................... 8 

Symbols ................................................................................................................................................. 8 

Flash ...................................................................................................................................................... 8 

Design ........................................................................................................................................................ 8 

Themes .................................................................................................................................................. 8 

Document Formatting ........................................................................................................................... 8 

Page Background................................................................................................................................... 8 

Layout........................................................................................................................................................ 8 

Page Setup ............................................................................................................................................ 8 

Paragraph .............................................................................................................................................. 9 

Arrange.................................................................................................................................................. 9 

References ................................................................................................................................................ 9 



 

2 
 

Table of Contents .................................................................................................................................. 9 

Footnotes .............................................................................................................................................. 9 

Citations & Bibliography ....................................................................................................................... 9 

Captions ................................................................................................................................................ 9 

Index .................................................................................................................................................... 10 

Table of Authorities ............................................................................................................................ 10 

Mailings ................................................................................................................................................... 10 

Create .................................................................................................................................................. 10 

Start Mail Merge ................................................................................................................................. 10 

Write and insert Fields ........................................................................................................................ 10 

Preview Results ................................................................................................................................... 10 

Finish ................................................................................................................................................... 11 

Acrobat ................................................................................................................................................ 11 

Review ..................................................................................................................................................... 11 

Proofing ............................................................................................................................................... 11 

Insights ................................................................................................................................................ 11 

Language ............................................................................................................................................. 11 

Comments ........................................................................................................................................... 11 

Tracking ............................................................................................................................................... 11 

Changes ............................................................................................................................................... 11 

Compare .............................................................................................................................................. 11 

Protect ................................................................................................................................................. 12 

OneNote .............................................................................................................................................. 12 

View ........................................................................................................................................................ 12 

Views ................................................................................................................................................... 12 

Show .................................................................................................................................................... 12 

Zoom ................................................................................................................................................... 12 

Window ............................................................................................................................................... 12 

Macros ................................................................................................................................................ 12 

Make a Heading that can be used in a table of contents. ...................................................................... 13 

How to Make a Table of Contents .......................................................................................................... 13 

How to Add References (Creating a Bibliography) ................................................................................. 13 

How to Insert a Bibliography (Table of References) ............................................................................... 13 



 

3 
 

How to Insert a Cover Page ..................................................................................................................... 13 

How to Use Microsoft Office Excel 2016 .................................................................................................... 24 

Home ....................................................................................................................................................... 24 

Clipboard ............................................................................................................................................. 24 

Font ..................................................................................................................................................... 24 

Alignment ............................................................................................................................................ 25 

Number ............................................................................................................................................... 25 

Styles ................................................................................................................................................... 25 

Cells ..................................................................................................................................................... 25 

Editing ................................................................................................................................................. 25 

Insert ....................................................................................................................................................... 25 

Tables .................................................................................................................................................. 25 

Illustrations ......................................................................................................................................... 26 

Add-ins ................................................................................................................................................ 26 

Charts .................................................................................................................................................. 26 

Tours ................................................................................................................................................... 26 

Sparkline’s ........................................................................................................................................... 26 

Filters ................................................................................................................................................... 26 

Links .................................................................................................................................................... 26 

Text ..................................................................................................................................................... 26 

Symbols ............................................................................................................................................... 26 

Page Layout ............................................................................................................................................. 27 

Themes ................................................................................................................................................ 27 

Page Setup .......................................................................................................................................... 27 

Scale to fit ........................................................................................................................................... 27 

Sheet options ...................................................................................................................................... 27 

Arrange................................................................................................................................................ 27 

Formulas ................................................................................................................................................. 27 

Insert Function .................................................................................................................................... 27 

Function Library .................................................................................................................................. 27 

Defined names .................................................................................................................................... 27 

Formula Auditing................................................................................................................................. 27 

Calculation .......................................................................................................................................... 27 



 

4 
 

Data ......................................................................................................................................................... 28 

Get External data ................................................................................................................................ 28 

Get & Transform ................................................................................................................................. 28 

Connections ........................................................................................................................................ 28 

Sort & Filter ......................................................................................................................................... 28 

Data Tools ........................................................................................................................................... 28 

Forecast ............................................................................................................................................... 28 

Outline................................................................................................................................................. 28 

Review ..................................................................................................................................................... 28 

Proofing ............................................................................................................................................... 28 

Insights ................................................................................................................................................ 28 

Language ............................................................................................................................................. 28 

Comments ........................................................................................................................................... 28 

Changes ............................................................................................................................................... 28 

View ........................................................................................................................................................ 28 

Workbook Views ................................................................................................................................. 28 

Show .................................................................................................................................................... 28 

Zoom ................................................................................................................................................... 28 

Window ............................................................................................................................................... 28 

Macros ................................................................................................................................................ 28 

How to Use Microsoft Office PowerPoint ................................................................................................... 44 

How to Use Microsoft Office OneNote ....................................................................................................... 45 

How to Use Microsoft Office Access ........................................................................................................... 45 

How to Use Microsoft Office Publisher ...................................................................................................... 45 

How to Use Microsoft Office Outlook ......................................................................................................... 46 

Home ....................................................................................................................................................... 46 

New ..................................................................................................................................................... 46 

Delete .................................................................................................................................................. 46 

Respond .............................................................................................................................................. 46 

Quick Steps .......................................................................................................................................... 46 

Move ................................................................................................................................................... 46 

Tags ..................................................................................................................................................... 46 

Find ...................................................................................................................................................... 47 



 

5 
 

Add ins................................................................................................................................................. 47 

Adobe send & Track ............................................................................................................................ 47 

Send/Received ........................................................................................................................................ 47 

Send & Receive ................................................................................................................................... 47 

Download ............................................................................................................................................ 47 

Server .................................................................................................................................................. 47 

Preferences ......................................................................................................................................... 47 

Folder ...................................................................................................................................................... 47 

New ..................................................................................................................................................... 47 

Actions ................................................................................................................................................ 48 

Clean Up .............................................................................................................................................. 49 

Favorites .............................................................................................................................................. 49 

Online View ......................................................................................................................................... 49 

Properties ............................................................................................................................................ 49 

View ........................................................................................................................................................ 50 

Current View ....................................................................................................................................... 50 

Messages ............................................................................................................................................. 50 

Arrangement ....................................................................................................................................... 51 

Layout .................................................................................................................................................. 51 

People Pane ........................................................................................................................................ 51 

Window ............................................................................................................................................... 51 

Adobe PDF ............................................................................................................................................... 51 

Convert ................................................................................................................................................ 51 

Preferences ......................................................................................................................................... 51 

Archive ................................................................................................................................................ 51 

Recall email: ............................................................................................................................................ 51 

Set up automatic reply: ........................................................................................................................... 52 

Set up meeting: ....................................................................................................................................... 52 

How to use the schedule assistant ......................................................................................................... 52 

How to Use Microsoft Office OneDrive for Business .................................................................................. 64 

 

  



 

6 
 

How to Use Microsoft Office Word 2016 
A brief overview of where things are in Word. 

For more information: https://support.office.com/en-us/article/Word-training-7bcd85e6-2c3d-4c3c-
a2a5-5ed8847eae73  

File 
- Info, New, Open, Save, Save as, Save as adobe, Print, Share, Close, Account, Options 

Home 
Clipboard 

- Copy and paste icons 
- Format painter: 

Highlight desired text click Format painter then highlight the text you want changed 

Font 
- Select your Font type and size 
- Increase or decrease font size while its highlighted 
- change casing while text is highlighted (UPPERCASE, lowercase, TOGGLE cASE, sentence casing, 

Capitalize Each Word 
- Clear all formatting 
- BOLD, Italic, Underlined,  Strikethrough 
- Insert lower and upper 

Paragraphs 
- Bullets, numbers, cascading  
- Align text left, right Center, straight across 
- Decrease, increase indent, order A-Z, show paragraph marks 
- Line paragraph spacing, shading behind text, show/hide borders on charts 

Styles 
- Various styles of headings and quick font options 

- Heading 1 
- Heading 2 
- Heading 3 
- Etc. 

Editing 
- Find (find, advanced find, go to) 
- Replace (find and replace) 
- Select(select all, select objects, select text with similar formatting, selection Pane) 

  

https://support.office.com/en-us/article/Word-training-7bcd85e6-2c3d-4c3c-a2a5-5ed8847eae73
https://support.office.com/en-us/article/Word-training-7bcd85e6-2c3d-4c3c-a2a5-5ed8847eae73
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Insert 
Pages 

- Cover Page 
- Blank Page 
- Page break (You can also Press CTRL + ENTER) 

Tables 
- Insert, draw, Excel, Quick Tables(calendar formats)  

Illustrations 
- Pictures (from the computer) 
- Online Pictures (searches with Bing) 
- Shapes (arrows, lines, boxes, circles etc.)  
- Smart Art (colorful information diagrams) 
- Chart (inserts a chart of your choice, pops up with a spot to fill the data) 
- Screenshot (available windows, screen clippings) 

Add-ins 
- Store (where to buy and download Office Add-ins) 
- My Add-ins(Where you view your add-ins) 
- Wikipedia(office Add-in to check your facts and search as well as highlight information and add it 

easily) 

Media 
- Online Video (Bing, YouTube, embedded code) 

Links 
- Hyperlink (link one of your files through this) 
- Bookmark (create a bookmark by adding Hyperlinks that will jump there for you) 
- Cross Reference (Reference other documents or within a document) 

Comments 
- Comments  
- (inserts a comment that is displayed to the left) 

Header & Footer 
- Header  
- Footer 
- Page Number 
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Text 
- Text box 
- Quick Parts 
 Auto Text puts in commonly used words 
 Document Property puts in Author, Company Etc. 
 Field (inserts a field such as Author, Company Etc.) 

- WordArt (inserts fancy text) 
- Drop Cap  

(Formats the first letter of the Sentence to a Large Picture, wither indented or on the left) 
- Signature Line 
- Date & Time (Gives you options for inserting the date and time 
- Object (insert older Word documents and PDF files 

Symbols 
- Insert various equation and symbols 
- Equation  
- Symbol 

Flash 
- Embed Flash 
- Embeds Flash videos 

 

Design 
Themes 

- Inserts themes which cover the whole document  

Document Formatting 
- Title and text themes,  
- Colors (selects a color pallet for your work)  
- Fonts (changes the font for the whole document, allows you to preview it as well)  
- Paragraph Spacing(changes spacing for the whole document) 
- Effects(changes the effect of Objects in the document, making them stand out) 
- Set as Default(sets the Design factors you have changed to affect all documents moving forward) 

Page Background 
- Watermark (insert a watermark to help prevent people from stealing your work) 
- Page Color (fil the background with a color, use fill effects to change the shading) 
- Page Borders (design a border for the document) 

Layout 
Page Setup 

- Margins (adjust the space from the edge for printing) 
- Orientation (landscape or portrait) 
- Columns (makes columns in the page without inserting tables) 
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- Breaks (insert line breaks) 
- Line Numbers(insert line numbers automatically, many styles available) 
- Hyphenation(turn on automatic hyphenation, or turn them off) 

Paragraph 
- Paragraph indents and spacing 
- Indent(left, right) 
- Spacing(before, after) 

Arrange 
- Position(where you want your picture to sit) 
- Wrap text (Have it in line, on top of text, behind text etc.) 
- Bring forward 
- Send backward 
- Selection Pane 
- Align 
- Group 
- Rotate 

 

References 
Table of Contents 

- Table of contents (using the heading styles will help with this, just select the style you want and 
update it accordingly. You can also do a custom table of contents) 

- Add text (Add the current heading into a table) 
- Update Table(updates the table can choose just numbers or whole table) 

Footnotes 
- Insert Footnote1 (You see the number(s) at the top and the notes at the bottom of the page) 
- Insert Endnotei (you will see the roman numerical at the top and it will send you to the bottom of the 

document for its notes, rather than end of the page) 
- Next Footnote (allows you to jump between footnotes and end notes easily) 
- Show Notes (moves the page to where the Footnotes are located or back to the reference 

number) 

Citations & Bibliography 
- Insert Citation (Wikihow, N/A)(puts a reference marker)  
- Manage Sources (Brings up Source Menu, manage your references) 
- Style (choose reference style APA, MLA, etc.) 
- Bibliography (inserts a bibliography 

Captions 
- Insert caption(Put a label on selected image) 

                                                           
1 This is  a Footnote 

Figure 1 this is a Caption 
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- Insert table of figures(Puts in a list of the figures shown below) 

 Figure 1 This is a Caption ................................................................................................................... 9 
- Update Table(updates the Table of Figures) 
- Cross-reference (allows you to quickly reference other parts of the document to display the page 

number for the field in question) 

Index 
- Mark Entry (makes the entry for Cross Referencing) 
- Insert index(Puts in an index of the Cross References) 
- Update Index(Updates the Index) 

Table of Authorities 
- Mark Citation (tell the readers certain materials came from another source) 
- Insert Table of Authorities 
- Update table  

 

Mailings 
Create 

- Envelopes (allows you to Print directly onto envelopes with certain printers, just set it up 
according to your needs)  

- Labels (allows you to print off multiple labels at the same time on the same page) 

Start Mail Merge 
- Start Mail Merge (allows you to create a template for sending various documents letters, 

envelopes etc.) 
- Select Recipients (type a new list, Choose from contacts, choose from outlook contacts)  
- Edit Recipient List (find duplicates, add/remove contacts) 

Write and insert Fields 
- Highlight Merge Fields (this will highlight all of the insert fields)  
- Address Block (Inserts the addresses from the ) 
- Greeting Line (inserts the dear (NAME) for you) 
- Insert Merge Field (various options to Choose from ) 
- Rules (set up various rules for the inserted fields) 
- Match Fields (set up the meaning of the different fields)  
- Update Labels (updates the information in the different fields ) 

Preview Results 
- Preview Results (Instead of showing <<field Name>> it will show the data which will be on the 

printed copy) 
- Find Recipients (Search for specific people from the list of recipients of this document) 
- Check for Errors (Checks it for any errors, as you go along, or after in a different document) 

file://WCFS01/DEPARTMENTS/INFORMATION%20TECHNOLOGY%20SERVICES/Common/HELPDESK/Lily/done/Office%20365%20instructions.docx#_Toc483380266
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Finish 
- Finish & Merge  

(Edit, Print or Send Email Messages) 

Acrobat 
- Merge to Adobe PDF 
(Sends it as a PDF Attachment to the specified recipients) 

 

Review 
Proofing 

- Spelling & Grammar(checks for errors, recommends corrections) 
- Thesaurus (shows recommendations for similar words, you can also sign into the dictionary for 

definitions) 
- Word Count Shows (The word count, pages, characters etc. You can also look at the bottom left 

of your document) 

Insights 
-  Smart Lookup  

(Provides definitions and web search through Bing, good for a quick reference)  

Language 
- Translate (translate the whole document, selected text, or mini translator) 
- Language (set proofing language and preferences) 

Comments 
- New comment (inserts a comment_ 
- Delete (removes a comment) 
- Previous (Skip to the previous comment) 
- Next (skip to the next comment) 
- Show Comments (shows the comments to the left of the screen) 

Tracking 
- Track Changes (displays changes from other authors in real time) 
- Markup (simple, all markups, no markups. How it displays) 
- Show Markup (view certain peoples changes and how its displayed) 
- Reviewing Pane (displays comments together  

Changes 
- Accept (accept the changes made by others, therefore saving it with changes) 
- Reject (reject the changes, reverts to the format before they changed it) 
- Previous and Next (skip to previous and next changes to be accepted or rejected) 

Compare 
-  Compare  

(Compare 2 or more documents to view the differences)  
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Protect 
-  Block Authors  

(Prevent authors from making changes) 
- Restrict editing (Restricts what they are able to change according to preferences) 

OneNote 
- Linked Notes 

(Use it to keep notes in OneNote, when you go through OneNote you can open the document) 

View 
Views 

- Read mode(like a book) 
- Print Layout (how it looks printing it out) 
- Web Layout (how It looks online) 

Show 
- Ruler (used for tab stops, and lining things up) 
- Gridlines (helps you line things up) 
- Navigation Pane (search the document, navigate pages, use the headings) 

 

Zoom 
- Zoom (gives you many options) 
- 100% (zooms in or out to 100%) 
- One Page (displays only one page) 
- Multiple Pages (zooms out to show 3 or 4 pages across the screen) 
- Page Width (zooms to the pages width) 

Window 
- New Window (opens a second copy of the document in a window) 
- Arrange All (stack windows to view all of them) 
- Split(view 2 parts at the same time) 
- View Side by Side (puts 2 open windows next to each other) 
- Synchronize Scrolling (scroll the 2 side by side documents at the same time) 
- Reset window Position (good for documents that you are comparing to make sure they scroll at 

the same time) 
- Switch Windows (use it to switch between open windows easily) 

Macros 
- Macros  

(Can view and record macros) 
A Macro is used to run a set of commands. This is useful for forms for a quick erase 
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Make a Heading that can be used in a table of contents. 
1. Type your document 
2. Highlight the Title 
3. Press Heading1, Heading2 etc.  

- It is in the Styles option in the Home Tab 
- Highlighted below 
- Remember Heading 2 will make it a sub heading 
- Remember Heading 3 will also make it a sub heading 
- Check “How to Make a Table of Contents” to see how it displays 

How to Make a Table of Contents 
1. Start by making your headings and subheadings 
2. Then Click the References Tab 
3. Click Table of Contents  

- Select desired format from the dropdown 
4. Displayed below.  

- Use the Update Table… to update the information contained in the Table of Contents 

How to Add References (Creating a Bibliography) 
1. Find where you want to make your reference 
2. Click the References Tab  

- Make sure it is in the Style you need (APA, MLA etc.) 
3. Click insert Citation 
4. Click Add New Source 
5. Fill in the appropriate fields 

- Change the source to the appropriate medium (Journal, website, picture etc.) 
- Click the Show All Bibliography fields for a more detailed reference 
6. It will now appear  

- similar to what is displayed below 

How to Insert a Bibliography (Table of References) 
1. Make sure you have all of your references added  

- Similar to the below image 
2. Click the References tab 
3. Click Bibliography  
4. From the drop down Pick a layout 
5. It will appear where ever you have last clicked on the document  

- Similar to below depending on style and information put into it 
- Use the Update Citations and Bibliography to make sure everything is up to date 

How to Insert a Cover Page 
1. Click the insert Tab 
2. Click the Cover Page 
3. Select the design you want 

- Fill in the appropriate fields 



 

14 
 

Keyboard shortcuts for Microsoft 
Word 2016 for Windows  
This article shows all keyboard shortcuts for Microsoft Word 2016.  

Notes:  

• If a shortcut requires two or more keys at the same time, the keys are separated by a plus sign 
(+). If you have to press one key immediately after another, the keys are separated by a comma 
(,). 

• The shortcuts in this article refer to the U.S. keyboard layout. Keys for other layouts might not 
correspond exactly to the keys on a U.S. keyboard. 

Frequently used shortcuts 
This table shows the most frequently used shortcuts in Microsoft Word. 

To do this Press 
Go to "Tell me what you want to do" Alt+Q 
Open Ctrl+O 
Save Ctrl+S 
Close Ctrl+W 
Cut Ctrl+X 
Copy Ctrl+C 
Paste Ctrl+V 
Select all Ctrl+A 
Bold Ctrl+B 
Italic Ctrl+I 
Underline Ctrl+U 
Decrease font size 1 point Ctrl+[ 
Increase font size 1 point Ctrl+] 
Center text Ctrl+E 
Left align text Ctrl+L 
Right align text Ctrl+R 
Cancel Esc 
Undo Ctrl+Z 
Re-do Ctrl+Y 
Zoom Alt+W, Q, then tab in Zoom dialog box to the 

value you want. 

Navigate the ribbon with only the keyboard 
The ribbon is the strip at the top of Word, organized by tabs. Each tab displays a different ribbon. 
Ribbons are made up of groups, and each group includes one or more commands. Every command in 
Word can be accessed by using shortcut.  
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Note: Add-ins and other programs may add new tabs to the ribbon and may provide access keys for 
those tabs. 

Access Keys for ribbon tabs 
There are two ways to navigate the tabs in the ribbon: 

• To go to the ribbon, press Alt, and then, to move between tabs, use the Right Arrow and Left 
Arrow keys.  

• To go directly to a specific tab on the ribbon, use one of the following access keys: 

To do this Press 
To use Backstage view, open the File page.  Alt+F 
To use themes, colors, and effects, such as page 
borders, open the Design tab.  

Alt+G 

To use common formatting commands, 
paragraph styles, or to use the Find tool. open 
Home tab. 

Alt+H 

To manage Mail Merge tasks, or to work with 
envelopes and labels, open Mailings tab . 

Alt+M 

To insert tables, pictures and shapes, headers, or 
text boxes, open Insert tab. 

Alt+N 

To work with page margins, page orientation, 
indentation, and spacing, open Layout tab. 

Alt+P 

To type a search term for Help content, open 
"Tell me" box on ribbon.  

Alt+Q, then enter the search term 

To use Spell Check, set proofing languages, or to 
track and review changes to your document, 
open the Review tab. 

Alt+R 

To add a table of contents, footnotes, or a table 
of citations, open the References tab. 

Alt+S 

To choose a document view or mode, such as 
Read Mode or Outline view, open the View tab. 
You can also set Zoom magnification and manage 
multiple windows of documents. 

Alt+W 

Use commands on a ribbon with the keyboard 
• To move to the list of ribbon tabs, press Alt; to go directly to a tab, press a keyboard shortcut.  

• To move into the ribbon, press the Down Arrow key. (JAWS refers to this action as a move to the 
lower ribbon.) 

• To move between commands, press the Tab key or Shift+Tab.  

• To move in the group that’s currently selected, press the Down Arrow key. 

• To move between groups on a ribbon, press Ctrl+Right Arrow or Ctrl+Left Arrow. 

Controls on the ribbon are activated in different ways, depending upon the type of control:  
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• If the selected command is a button, to activate it, press Spacebar or Enter. 

• If the selected command is a split button (that is, a button that opens a menu of additional 
options), to activate it, press Alt+Down Arrow. Tab through the options. To select the current 
option, press Spacebar or Enter.  

• If the selected command is a list (such as the Font list), to open the list, press the Down Arrow 
key. Then, to move between items, use the Up Arrow or Down Arrow key. 

• If the selected command is a gallery, to select the command, press Spacebar or Enter. Then, tab 
through the items.  

Tip: In galleries with more than one row of items, the Tab key moves from the beginning to the end of 
the current row and, when it reaches the end of the row, it moves to the beginning of the next one. 
Pressing the Right Arrow key at the end of the current row moves back to the beginning of the current 
row.  

Use access keys when you can see the KeyTips  
To use access keys: 

1. Press Alt. 

2. Press the letter shown in the square KeyTip that appears over the ribbon command that you 
want to use. 

Depending on which letter you press, you may be shown additional KeyTips, which are small images of a 
letter next to a command button on the tab that you picked. For example, if you press Alt+F, the Office 
Backstage opens on the Info page which has a different set of KeyTips. If you then press Alt again, 
KeyTips for navigating on this page appear.  

Change the keyboard focus by using the keyboard without using the mouse 
The following table lists some ways to move the keyboard focus when using only the keyboard. 

To do this  Press  
Select the active tab of the ribbon and activate 
the access keys. 

Alt or F10. Use access keys or arrow keys to move 
to a different tab. 

Move the focus to commands on the ribbon. Tab or Shift+Tab 
Move the focus to each command on the ribbon, 
forward or backward, respectively. 

Tab or Shift+Tab 

Move down, up, left, or right, respectively, 
among the items on the ribbon. 

Down Arrow, Up Arrow, Left Arrow, or Right 
Arrow 

Expand or collapse the ribbon. Ctrl+F1 
Display the shortcut menu for a selected item. Shift+F10 
Move the focus to a different pane of the 
window, such as the Format Picture pane, the 
Grammar pane, or the Selection pane . 

F6 

Activate a selected command or control on the 
ribbon. 

Spacebar or Enter 

Open a selected menu or gallery on the ribbon. Spacebar or Enter 
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Finish modifying a value in a control on the 
ribbon, and move focus back to the document. 

Enter 

Keyboard shortcut reference for Microsoft Word 
Create and edit documents  
Create, view, and save documents 

To do this  Press  
Create a new document. Ctrl+N 
Open a document. Ctrl+O 
Close a document. Ctrl+W 
Split the document window. Alt+Ctrl+S 
Remove the document window split. Alt+Shift+C or Alt+Ctrl+S 
Save a document. Ctrl+S 

Work with web content and hyperlinks 
To do this  Press  
Insert a hyperlink. Ctrl+K 
Go back one page. Alt+Left Arrow 
Go forward one page. Alt+Right Arrow 
Refresh. F9 

Print and preview documents 
To do this  Press  
Print a document. Ctrl+P 
Switch to print preview. Alt+Ctrl+I 
Move around the preview page when zoomed in. Arrow keys 
Move by one preview page when zoomed out. Page Up or Page Down 
Move to the first preview page when zoomed 
out. 

Ctrl+Home 

Move to the last preview page when zoomed out. Ctrl+End 
Check spelling and review changes in a document 

To do this  Press  
Insert a comment (in the Revision task pane). Alt+R, C 
Turn change tracking on or off. Ctrl+Shift+E 
Close the Reviewing Pane if it is open. Alt+Shift+C 
Select Review tab on ribbon. Alt+R, then Down Arrow to move to commands 

on this tab. 
Select Spelling & Grammar  Alt+R, S 

Find, replace, and go to specific items in the document 
To do this  Press  
Open the search box in the Navigation task pane. Ctrl+F 
Replace text, specific formatting, and special 
items. 

Ctrl+H 

Go to a page, bookmark, footnote, table, 
comment, graphic, or other location. 

Ctrl+G 
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Switch between the last four places that you have 
edited. 

Alt+Ctrl+Z 

Move around in a document using the keyboard 
To move  Press  
One character to the left Left Arrow 
One character to the right Right Arrow 
One word to the left Ctrl+Left Arrow 
One word to the right Ctrl+Right Arrow 
One paragraph up Ctrl+Up Arrow 
One paragraph down Ctrl+Down Arrow 
One cell to the left (in a table) Shift+Tab 
One cell to the right (in a table) Tab 
Up one line Up Arrow 
Down one line Down Arrow 
To the end of a line End 
To the beginning of a line Home 
To the top of the window Alt+Ctrl+Page Up 
To the end of the window Alt+Ctrl+Page Down 
Up one screen (scrolling) Page Up 
Down one screen (scrolling) Page Down 
To the top of the next page Ctrl+Page Down 
To the top of the previous page Ctrl+Page Up 
To the end of a document Ctrl+End 
To the beginning of a document Ctrl+Home 
To a previous revision Shift+F5 
After opening a document, to the location you 
were working in when the document was last 
closed 

Shift+F5 

Insert or mark Table of Contents, footnotes, and citations 
To do this  Press  
Mark a table of contents entry. Alt+Shift+O 
Mark a table of authorities entry (citation). Alt+Shift+I 
Mark an index entry. Alt+Shift+X 
Insert a footnote. Alt+Ctrl+F 
Insert an endnote. Alt+Ctrl+D 
Go to next footnote (in Word 2016). Alt+Shift+> 
Go to previous footnote (in Word 2016). Alt+Shift+< 
Go to "Tell me what you want to do" and Smart 
Lookup (in Word 2016). 

Alt+Q 

Work with documents in different views 
Word offers several different views of a document. Each view makes it easier to do certain tasks. For 
example, Read Mode enables you to present two pages of the document side by side, and to use an 
arrow navigation to move to the next page. 
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Switch to another view of the document 
To do this  Press  
Switch to Read Mode view Alt+W, F 
Switch to Print Layout view. Alt+Ctrl+P 
Switch to Outline view. Alt+Ctrl+O 
Switch to Draft view. Alt+Ctrl+N 

Work with headings in Outline view 
These shortcuts only apply if a document is in Outline view. 

To do this  Press  
Promote a paragraph. Alt+Shift+Left Arrow 
Demote a paragraph. Alt+Shift+Right Arrow 
Demote to body text. Ctrl+Shift+N 
Move selected paragraphs up. Alt+Shift+Up Arrow 
Move selected paragraphs down. Alt+Shift+Down Arrow 
Expand text under a heading. Alt+Shift+Plus Sign 
Collapse text under a heading. Alt+Shift+Minus Sign 
Expand or collapse all text or headings. Alt+Shift+A 
Hide or display character formatting. The slash (/) key on the numeric keypad 
Show the first line of text or all text. Alt+Shift+L 
Show all headings with the Heading 1 style. Alt+Shift+1 
Show all headings up to Heading n. Alt+Shift+n 
Insert a tab character. Ctrl+Tab 

Navigate in Read Mode view 
To do this  Press  
Go to beginning of document. Home 
Go to end of document. End 
Go to page n. n (n is the page number you want to go to), Enter 
Exit Read mode. Esc 

Edit and move text and graphics 
Select text and graphics 

• Select text by holding down Shift and using the arrow keys to move the cursor 

Extend a selection 
To do this  Press  
Turn extend mode on. F8 
Select the nearest character. F8, and then press Left Arrow or Right Arrow 
Increase the size of a selection. F8 (press once to select a word, twice to select a 

sentence, and so on) 
Reduce the size of a selection. Shift+F8 
Turn extend mode off. Esc 
Extend a selection one character to the right. Shift+Right Arrow 
Extend a selection one character to the left. Shift+Left Arrow 
Extend a selection to the end of a word. Ctrl+Shift+Right Arrow 
Extend a selection to the beginning of a word. Ctrl+Shift+Left Arrow 
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Extend a selection to the end of a line. Shift+End 
Extend a selection to the beginning of a line. Shift+Home 
Extend a selection one line down. Shift+Down Arrow 
Extend a selection one line up. Shift+Up Arrow 
Extend a selection to the end of a paragraph. Ctrl+Shift+Down Arrow 
Extend a selection to the beginning of a 
paragraph. 

Ctrl+Shift+Up Arrow 

Extend a selection one screen down. Shift+Page Down 
Extend a selection one screen up. Shift+Page Up 
Extend a selection to the beginning of a 
document. 

Ctrl+Shift+Home 

Extend a selection to the end of a document. Ctrl+Shift+End 
Extend a selection to the end of a window. Alt+Ctrl+Shift+Page Down 
Extend a selection to include the entire 
document. 

Ctrl+A 

Select a vertical block of text. Ctrl+Shift+F8, and then use the arrow keys; press 
Esc to cancel selection mode 

Extend a selection to a specific location in a 
document. 

F8+arrow keys; press Esc to cancel selection 
mode 

Delete text and graphics 
To do this  Press  
Delete one character to the left. Backspace 
Delete one word to the left. Ctrl+Backspace 
Delete one character to the right. Delete 
Delete one word to the right. Ctrl+Delete 
Cut selected text to the Office Clipboard. Ctrl+X 
Undo the last action. Ctrl+Z 
Cut to the Spike. (Spike is a feature that allows 
you to collect groups of text from different 
locations and paste them in another location). 

Ctrl+F3 

Copy and move text and graphics 
To do this  Press  
Open the Office Clipboard Press Alt+H to move to the Home tab, and then 

press F,O. 
Copy selected text or graphics to the Office 
Clipboard. 

Ctrl+C 

Cut selected text or graphics to the Office 
Clipboard. 

Ctrl+X 

Paste the most recent addition or pasted item 
from the Office Clipboard. 

Ctrl+V 

Move text or graphics once. F2 (then move the cursor and press Enter) 
Copy text or graphics once. Shift+F2 (then move the cursor and press Enter) 
When text or an object is selected, open the 
Create New Building Block dialog box.  

Alt+F3 
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When the building block — for example, a 
SmartArt graphic — is selected, display the 
shortcut menu that is associated with it. 

Shift+F10 

Cut to the Spike. Ctrl+F3 
Paste the Spike contents. Ctrl+Shift+F3 
Copy the header or footer used in the previous 
section of the document. 

Alt+Shift+R 

Edit and navigate tables 
Select text and graphics in a table 

To do this  Press  
Select the next cell's contents. Tab 
Select the preceding cell's contents. Shift+Tab 
Extend a selection to adjacent cells. Hold down Shift and press an arrow key 

repeatedly 
Select a column. Use the arrow keys to move to the column's top 

or bottom cell, and then do one of the following: 
Press Shift+Alt+Page Down to select the column 
from top to bottom. 

Press Shift+Alt+Page Up to select the column 
from bottom to top. 

Select an entire row Use arrow keys to move to end of the row, either 
the first cell (leftmost) in the row or to the last 
cell (rightmost) in the row. 

From the first cell in the row, press Shift+Alt+End 
to select the row from left to right. 

From the last cell in the row, press 
Shift+Alt+Home to select the row from right to 
left. 

Extend a selection (or block). Ctrl+Shift+F8, and then use the arrow keys; press 
Esc to cancel selection mode 

Select an entire table. Alt+5 on the numeric keypad (with Num Lock off) 
Move around in a table 

To move  Press  
To the next cell in a row Tab 
To the previous cell in a row Shift+Tab 
To the first cell in a row Alt+Home 
To the last cell in a row Alt+End 
To the first cell in a column Alt+Page Up 
To the last cell in a column Alt+Page Down 
To the previous row Up Arrow 
To the next row Down Arrow 
Row up Alt+Shift+Up Arrow 
Row down Alt+Shift+Down Arrow 

Insert paragraphs and tab characters in a table 
To insert  Press  
New paragraphs in a cell Enter 
Tab characters in a cell Ctrl+Tab 
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Format characters and paragraphs 
Format characters 

To do this  Press  
Open the Font dialog box to change the 
formatting of characters. 

Ctrl+D 

Change the case of letters. Shift+F3 
Format all letters as capitals. Ctrl+Shift+A 
Apply bold formatting. Ctrl+B 
Apply an underline. Ctrl+U 
Underline words but not spaces. Ctrl+Shift+W 
Double-underline text. Ctrl+Shift+D 
Apply hidden text formatting. Ctrl+Shift+H 
Apply italic formatting. Ctrl+I 
Format letters as small capitals. Ctrl+Shift+K 
Apply subscript formatting (automatic spacing). Ctrl+Equal Sign 
Apply superscript formatting (automatic spacing). Ctrl+Shift+Plus Sign 
Remove manual character formatting. Ctrl+Spacebar 
Change the selection to the Symbol font. Ctrl+Shift+Q 

Change or re-size the font 
To do this  Press  
Open the Font dialog box to change the font. Ctrl+Shift+F 
Increase the font size. Ctrl+Shift+> 
Decrease the font size. Ctrl+Shift+< 
Increase the font size by 1 point. Ctrl+] 
Decrease the font size by 1 point. Ctrl+[ 

Copy formatting 
To do this  Press  
Copy formatting from text. Ctrl+Shift+C 
Apply copied formatting to text. Ctrl+Shift+V 

Change paragraph alignment 
To do this  Press  
Switch a paragraph between centered and left-
aligned. 

Ctrl+E 

Switch a paragraph between justified and left-
aligned. 

Ctrl+J 

Switch a paragraph between right-aligned and 
left-aligned. 

Ctrl+R 

Left align a paragraph. Ctrl+L 
Indent a paragraph from the left. Ctrl+M 
Remove a paragraph indent from the left. Ctrl+Shift+M 
Create a hanging indent. Ctrl+T 
Reduce a hanging indent. Ctrl+Shift+T 
Remove paragraph formatting. Ctrl+Q 
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Copy and review text formats 
To do this  Press  
Display nonprinting characters. Ctrl+Shift+* (asterisk on numeric keypad does not 

work) 
Review text formatting. Shift+F1 (then click the text with the formatting 

you want to review) 
Copy formats. Ctrl+Shift+C 
Paste formats. Ctrl+Shift+V 

Set line spacing 
To do this  Press  
Single-space lines. Ctrl+1 
Double-space lines. Ctrl+2 
Set 1.5-line spacing. Ctrl+5 
Add or remove one line space preceding a 
paragraph. 

Ctrl+0 (zero) 

Apply Styles to paragraphs 
To do this  Press  
Open Apply Styles task pane. Ctrl+Shift+S 
Open Styles task pane. Alt+Ctrl+Shift+S 
Start AutoFormat. Alt+Ctrl+K 
Apply the Normal style. Ctrl+Shift+N 
Apply the Heading 1 style. Alt+Ctrl+1 
Apply the Heading 2 style. Alt+Ctrl+2 
Apply the Heading 3 style. Alt+Ctrl+3 

To close the Styles task pane 
1. If the Styles task pane is not selected, press F6 to select it. 

2. Press Ctrl+Spacebar. 

3. Use the arrow keys to select Close, and then press Enter. 

Insert special characters 
To insert this  Press  
A field Ctrl+F9 
A line break Shift+Enter 
A page break Ctrl+Enter 
A column break Ctrl+Shift+Enter 
An em dash Alt+Ctrl+Minus Sign (on the numeric keypad) 
An en dash Ctrl+Minus Sign (on the numeric keypad) 
An optional hyphen Ctrl+Hyphen 
A nonbreaking hyphen Ctrl+Shift+Hyphen 
A nonbreaking space Ctrl+Shift+Spacebar 
The copyright symbol Alt+Ctrl+C 
The registered trademark symbol Alt+Ctrl+R 
The trademark symbol Alt+Ctrl+T 
An ellipsis Alt+Ctrl+Period 
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A single opening quotation mark Ctrl+`(single quotation mark), `(single quotation 
mark) 

A single closing quotation mark Ctrl+' (single quotation mark), ' (single quotation 
mark) 

Double opening quotation marks Ctrl+` (single quotation mark), Shift+' (single 
quotation mark) 

Double closing quotation marks Ctrl+' (single quotation mark), Shift+' (single 
quotation mark) 

An AutoText entry Enter (after you type the first few characters of 
the AutoText entry name and when the ScreenTip 
appears) 

Insert characters by using character codes 
To do this  Press  
Insert the Unicode character for the specified 
Unicode (hexadecimal) character code. For 
example, to insert the euro currency symbol ( ), 
type 20AC, and then hold down Alt and press X. 

The character code, Alt+X 

Find out the Unicode character code for the 
selected character 

Alt+X 

Insert the ANSI character for the specified ANSI 
(decimal) character code. For example, to insert 
the euro currency symbol, hold down Alt and 
press 0128 on the numeric keypad. 

Alt+the character code (on the numeric keypad) 

 

How to Use Microsoft Office Excel 2016 
Below lists most of the features and where to look. Brief overview of what does what. 

For more information please check: https://support.office.com/en-us/article/Excel-training-9bc05390-
e94c-46af-a5b3-d7c22f6990bb  

Home 
Clipboard 

- Copy and paste icons 
- Format painter: 

 Highlight desired text click Format painter then highlight the text you want changed 

Font 
- Select your Font type and size 
- Increase or decrease font size while its highlighted 
- change casing while text is highlighted (UPPERCASE, lowercase, TOGGLE cASE, sentence casing, 

Capitalize Each Word 
- Clear all formatting 
- BOLD, Italic, Underlined,  Strikethrough 
- Insert lower and upper casing 

https://support.office.com/en-us/article/Excel-training-9bc05390-e94c-46af-a5b3-d7c22f6990bb
https://support.office.com/en-us/article/Excel-training-9bc05390-e94c-46af-a5b3-d7c22f6990bb
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Alignment 
- Top, middle, bottom of the cells text alignment within the cell 
- Left, middle and right text alignment within the cell 
- Font direction (angles, up down etc.) 
- Changing the indent left or right 
- Wrap text (it will cover multiple cells so you can view it) 
- Merge and center (merge, unmerge etc.) 

Number 
-  Number formats available (general, number, accounting etc.) 
-  Insert money signs in the cells($dollar, €euro, etc.), change to %Percent and 0.0Decimal 
-  Increase, decrease decimal position 

Styles 
-  Conditional Formatting 

o Highlight < than, > than, between etc.  
o Highlight top 10, bottom 10 etc. 
o Highlight bar with data (50% would highlight half the cell etc.) 
o Color according to data 
o Insert Icons into the cells 
o Create new rule 
o Clear rules 
o Manage rules 

-  Format as Table 
o Style as a table( highlight desired data and select this) 

-  Cell Styles 
o Offers color schemes, data highlighting etc. 

Cells 
-  Insert  

o Cells, Rows, Columns 
-  Delete  

o Cells, Rows, Columns 
- Format 

o Cells size, Visibility, Organize sheets, Protect sheets (password protect data) 

Editing 
- AutoSum (sum, average, count etc.) 
- Fill (down, right, left right etc.) 
- Clear (clear all, clear formats, clear contents etc.) 
- Sort and Filter (A-Z, Z-A, Custom etc.) 
- Find and select (Find, replace, formulas comments etc.) 

Insert 
Tables 

- Pivot Table 
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- Recommended Pivot Table 
- Table 

Illustrations 
- Pictures 
- Online Pictures 
- Shapes 
- Smart art Graphic 
- Screenshot 

Add-ins 
- Store 
- Bing 
- My Add-ins 
- Transform cold Data to Cool pictures 

Charts 
1. Recommend Charts 
2. Column, hierarchy, waterfall or stock chart 
3. Line, statistic, combo 
4. Pie, scatter, surface/radar 
5. Pivot charts 

Tours 
6. 3D Map 

Sparkline’s 
7. Represents a single line of data 

a. Line, Column, Win/Loss 

Filters 
8. Slicer 
9. Timeline 

Links 
10. Hyperlink 

Text 
11. Textbox 
12. Header and footer 
13. Word art 
14. Signature line 
15. Object 

Symbols 
16. Equation 
17. Symbol 
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Page Layout 
Themes 

18. Themes 
19. Colors 
20. Fonts 
21. Effects 

Page Setup 
22. Margins 
23. Orientation 
24. Size 
25. Print Area 
26. Breaks 
27. Background (image) 
28. Print Titles 

Scale to fit 
29. Width 
30. Height 
31. Scale 

Sheet options 
- Gridlines 
- Headings 

Arrange 
- Bring forward, send backward, selection Pane, Align, Group, Rotate 
-  

Formulas 
Insert Function 

- Quick link to insert Function 

Function Library 
- Grouped for selecting a certain function 

Defined names 
Formula Auditing 
Calculation 
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Data 
Get External data 
Get & Transform 
Connections 
Sort & Filter 
Data Tools 
Forecast 
Outline 
 

Review 
Proofing 
Insights 
Language 
Comments 
Changes 
 

View 
Workbook Views 
Show 
Zoom 
Window 
Macros 
 

Excel keyboard shortcuts and 
function keys 
This article describes keyboard shortcuts, function keys, and some other common shortcut keys for 
Microsoft Excel 2016 for Windows. This includes the shortcuts that you can use to access the ribbon.  

Tip  To keep this reference available when you work, you may want to print this topic. To print this 
topic, press CTRL+P. 

Notes  
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• These shortcuts refer to the US keyboard layout. Keys for other layouts might not correspond 
exactly to the keys on a US keyboard. 

• If a shortcut requires pressing two or more keys at the same time, this topic separates the 
keys with a plus sign (+). If you have to press one key immediately after another, the keys are 
separated by a comma (,). 

Frequently used shortcuts 

This table lists the most frequently used shortcuts in Excel 2016. 

To do this Press 
Close a spreadsheet Ctrl+W 
Open a spreadsheet Ctrl+O 
Go to the Home tab Alt+H 
Save a spreadsheet Ctrl+S 
Copy Ctrl+C 
Paste Ctrl+V 
Undo Ctrl+Z 
Remove cell contents Delete key 
Choose a fill color Alt+H, H 
Cut Ctrl+X 
Go to Insert tab Alt+N 
Bold Ctrl+B 
Center align cell contents Alt+H, A, then C 
Go to Page Layout tab Alt+P 
Go to Data tab Alt+A 
Go to View tab Alt+W 
Format a cell from context menu Shift+F10, or 

Context key 
Add borders Alt+H, B 
Delete column Alt+H,D, then C 
Go to Formula tab Alt+M 

 

Keyboard shortcuts to navigate the Ribbon 

If you're new to the Ribbon, the information in this section can help you understand the Ribbon's 
keyboard shortcut model. The Ribbon comes with new shortcuts, called Access Keys. To see visible 
key tips for the access keys, just press the Alt key.  
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To display a tab on the Ribbon, press the Alt key plus the letter for the tab—for example, press Alt+ 
N for the Insert tab or Alt+M for the Formulas tab. When you display a tab this way, the Key Tip 
badges for that tab's buttons also appear. Then, press the key for the button you want. 

• To go to the Ribbon, press Alt, and then, to move between tabs, use the Right Arrow and Left 
Arrow keys.  

• To hide the Ribbon so you have more room to work, press Ctrl+F1. Repeat to display the Ribbon 
again.  

Go to the access keys for the Ribbon 

To go directly to a tab on the Ribbon, press one of the following access keys: 

To do this Press 
Open the Tell me box on the Ribbon and type a search term for assistance 
or Help content.  

Alt+Q, and then 
enter the search 
term. 

Open the File page and use Backstage view.  Alt+F  
Open the Home tab and format text and numbers and use the Find tool.  Alt+H 
Open the Insert tab and insert PivotTables, charts, add-ins, Sparklines, 
pictures, shapes, headers, or text boxes.  

Alt+N 

Open the Draw tab to select a drawing tool, color and line thickness. Alt+JI 
Open the Page Layout tab and work with themes, page setup, scale, and 
alignment.  

Alt+P 

Open the Formulas tab and insert, trace, and customize functions and 
calculations.  

Alt+M 

Open the Data tab and connect to, sort, filter, analyze, and work with data.  Alt+A  
Open the Review tab and check spelling, add comments, and protect sheets 
and workbooks.  

Alt+R 

Open the View tab and preview page breaks and layouts, show and hide 
gridlines and headings, set zoom magnification, manage windows and 
panes, and view macros.  

Alt+W 

 

Work in the Ribbon tabs and menus with the keyboard  
To do this Press 
Select the active tab of the Ribbon, and activate 
the access keys.  

Alt or F10. To move to a different tab, use 
access keys or the arrow keys.  

Move the focus to commands on the Ribbon.  Tab or Shift+Tab  
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To do this Press 
Move down, up, left, or right, respectively, 
among the items on the Ribbon.  

The Down Arrow, Up Arrow, Left Arrow, or 
Right Arrow key  

Activate a selected button.  Spacebar or Enter  
Open the list for a selected command. The Down Arrow key  
Open the menu for a selected button.  Alt+Down Arrow  
When a menu or submenu is open, move to the 
next command.  

Down Arrow key  

Expand or collapse the Ribbon.  Ctrl+F1  
Open a context menu.  Shift+F10 or 

Context key (Windows keyboard only) 
Move to the submenu when a main menu is 
open or selected. 

Left Arrow key 

 

Reference: Keyboard shortcuts in Excel 2016 
Navigate in cells: keyboard shortcuts 

To do this Press 
Move to the previous cell in a worksheet or the previous option in a dialog box.  Shift+Tab 
Move one cell up in a worksheet.  Up Arrow key 
Move one cell down in a worksheet.  Down Arrow 

key 
Move one cell left in a worksheet.  Left Arrow key  
Move one cell right in a worksheet.  Right Arrow key  
Move to the edge of the current data region in a worksheet.  Ctrl+Arrow key  
Enter End mode, move to the next nonblank cell in the same column or row as 
the active cell, and turn off End mode. If the cells are blank, move to the last cell 
in the row or column.  

End, Arrow key 

Move to the last cell on a worksheet, to the lowest used row of the rightmost 
used column.  

Ctrl+End  

Extend the selection of cells to the last used cell on the worksheet (lower-right 
corner).  

Ctrl+Shift+End  

Move to the cell in the upper-left corner of the window when Scroll Lock is 
turned on.  

Home+Scroll 
Lock 

Move to the beginning of a row in a worksheet. Home Move to the beginning 
of a worksheet.  

Ctrl+Home 

Move one screen down in a worksheet.  Page Down 
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To do this Press 
Move to the next sheet in a workbook.  Ctrl+Page 

Down  
Move one screen to the right in a worksheet.  Alt+Page Down  
Move one screen up in a worksheet.  Page Up 
Move one screen to the left in a worksheet.  Alt+Page Up  
Move to the previous sheet in a workbook.  Ctrl+Page Up  
Move one cell to the right in a worksheet. Or, in a protected worksheet, move 
between unlocked cells.  

Tab  

 

Format in cells: keyboard shortcuts 
To do this Press 
Format a cell by using the Format Cells dialog box. Ctrl+1  
Format fonts in the Format Cells dialog box.  Ctrl+Shift+F or 

Ctrl+Shift+P  
Edit the active cell and put the insertion point at the end of its 
contents. Or, if editing is turned off for the cell, move the insertion 
point into the formula bar. If editing a formula, toggle Point mode off 
or on so you can use arrow keys to create a reference.  

F2 

Add or edit a cell comment.  Shift+F2 
Insert blank cells with the Insert dialog box.  Ctrl+Shift+Plus (+) 
Display the Delete dialog box to delete selected cells.  Ctrl+Minus (-) 
Enter the current time.  Ctrl+Shift+colon (:)  
Enter the current date.  Ctrl+semi-colon (;) 
Switch between displaying cell values or formulas in the worksheet.  Ctrl+grave accent (`)  
Copy a formula from the cell above the active cell into the cell or the 
Formula Bar.  

Ctrl+apostrophe (') 

Move the selected cells.  Ctrl+X 
Copy the selected cells.  Ctrl+C 
Paste content at the insertion point, replacing any selection.  Ctrl+V  
Paste content by using the Paste Special dialog box.  Ctrl+Alt+V 
Italicize text or remove italic formatting.  Ctrl+I or Ctrl+3 
Bold text or remove bold formatting.  Ctrl+B or Ctrl+2 
Underline text or remove underline.  Ctrl+U or Ctrl+4 
Apply or remove strikethrough formatting.  Ctrl+5 
Switch between hiding objects, displaying objects, and displaying 
placeholders for objects.  

Ctrl+6 

Apply an outline border to the selected cells.  Ctrl+Shift+ampersand 
(&) 
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To do this Press 
Remove the outline border from the selected cells.  Ctrl+Shift+underline (_) 
Display or hide the outline symbols.  Ctrl+8 
Hide the selected rows.  Ctrl+9 
Hide the selected columns.  Ctrl+0 
Use the Fill Down command to copy the contents and format of the 
topmost cell of a selected range into the cells below.  

Ctrl+D 

Use the Fill Right command to copy the contents and format of the 
leftmost cell of a selected range into the cells to the right.  

Ctrl+R 

Apply the General number format.  Ctrl+Shift+tilde (~) 
Apply the Currency format with two decimal places (negative numbers 
in parentheses). 

Ctrl+Shift+dollar sign ($) 

Apply the Percentage format with no decimal places.  Ctrl+Shift+percent (%) 
Apply the Scientific number format with two decimal places. Ctrl+Shift+caret (^) 
Apply the Date format with the day, month, and year.  Ctrl+Shift+number sign 

(#) 
Apply the Time format with the hour and minute, and AM or PM.  Ctrl+Shift+at sign (@) 
Apply the Number format with two decimal places, thousands 
separator, and minus sign (-) for negative values.  

Ctrl+Shift+exclamation 
point (!)  

Create or edit a hyperlink.  Ctrl+K  
Check spelling in the active worksheet or selected range.  F7 
Display the Quick Analysis options for selected cells that contain data.  Ctrl+Q  
Display the Create Table dialog box.  Ctrl+L or Ctrl+T  

 

 

Make selections and perform actions: keyboard shortcuts 
To do this Press 
Select the entire worksheet.  Ctrl+A or Ctrl+Shift+Spacebar  
Select the current and next sheet in a workbook.  Ctrl+Shift+Page Down 
Select the current and previous sheet in a workbook.  Ctrl+Shift+Page Up 
Extend the selection of cells by one cell.  Shift+arrow key 
Extend the selection of cells to the last nonblank cell in 
the same column or row as the active cell, or if the next 
cell is blank, to the next nonblank cell.  

Ctrl+Shift+arrow key  

Turn extend mode on and use the arrow keys to extend 
a selection. Press again to turn off. 

Turn extend mode on and use the arrow 
keys to extend a selection. Press again 
to turn off. F8 
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To do this Press 
Add a non-adjacent cell or range to a selection of cells 
by using the arrow keys.  

Shift+F8  

Start a new line in the same cell.  Alt+Enter  
Fill the selected cell range with the current entry.  Ctrl+Enter  
Complete a cell entry and select the cell above.  Shift+Enter 
Select an entire column in a worksheet.  Ctrl+Spacebar 
Select an entire row in a worksheet.  Shift+Spacebar  
Select all objects on a worksheet when an object is 
selected.  

Ctrl+Shift+Spacebar 

Extend the selection of cells to the beginning of the 
worksheet.  

Ctrl+Shift+Home  

Select the current region if the worksheet contains data. 
Press a second time to select the current region and its 
summary rows. Press a third time to select the entire 
worksheet.  

Ctrl+A or Ctrl+Shift+Spacebar  

Select the current region around the active cell or select 
an entire PivotTable report.  

Ctrl+Shift+asterisk (*)  

Select the first command on the menu when a menu or 
submenu is visible.  

Home  

Repeat the last command or action, if possible.  Ctrl+Y  
Undo the last action.  Ctrl+Z 

 

Work with data, functions, and the formula bar: keyboard shortcuts 
To do this Press 
Select an entire PivotTable report.  Ctrl+Shift+asterisk (*) 
Edit the active cell and put the insertion point at the end of its contents. 
Or, if editing is turned off for the cell, move the insertion point into the 
formula bar. If editing a formula, toggle Point mode off or on so you can 
use arrow keys to create a reference.  

F2  

Expand or collapse the formula bar.  Ctrl+Shift+U 
Cancel an entry in the cell or Formula Bar.  Esc 
Complete an entry in the formula bar and select the cell below.  Enter 
Move the cursor to the end of the text when in the formula bar.  Ctrl+End  
Select all text in the formula bar from the cursor position to the end.  Ctrl+Shift+End 
Calculate all worksheets in all open workbooks.  F9  
Calculate the active worksheet. Shift+F9  
Calculate all worksheets in all open workbooks, regardless of whether 
they have changed since the last calculation.  

Ctrl+Alt+F9 
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To do this Press 
Check dependent formulas, and then calculate all cells in all open 
workbooks, including cells not marked as needing to be calculated.  

Ctrl+Alt+Shift+F9  

Display the menu or message for an Error Checking button.  Alt+Shift+F10  
Display the Function Arguments dialog box when the insertion point is 
to the right of a function name in a formula.  

Ctrl+A  

Insert argument names and parentheses when the insertion point is to 
the right of a function name in a formula.  

Ctrl+Shift+A  

Invoke Flash Fill to automatically recognize patterns in adjacent columns 
and fill the current column 

Ctrl+E  

Cycle through all combinations of absolute and relative references in a 
formula if a cell reference or range is selected.  

F4  

Insert a function.  Shift+F3  
Copy the value from the cell above the active cell into the cell or the 
formula bar.  

Ctrl+Shift+straight 
quotation mark (") 

Create an embedded chart of the data in the current range.  Alt+F1 
Create a chart of the data in the current range in a separate Chart sheet.  F11  
Define a name to use in references.  Alt+M, M, D 
Paste a name from the Paste Name dialog box (if names have been 
defined in the workbook.  

F3  

Move to the first field in the next record of a data form.  Enter  
Create, run, edit, or delete a macro.  Alt+F8  
Open the Microsoft Visual Basic For Applications Editor.  Alt+F11 

 

Function keys 
Key Description 
F1 Displays the Excel Help task pane. 

Ctrl+F1 displays or hides the ribbon. 

Alt+F1 creates an embedded chart of the data in the current range. 

Alt+Shift+F1 inserts a new worksheet. 
F2 Edit the active cell and put the insertion point at the end of its contents. Or, if editing is 

turned off for the cell, move the insertion point into the formula bar. If editing a formula, 
toggle Point mode off or on so you can use arrow keys to create a reference. 

Shift+F2 adds or edits a cell comment. 
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Key Description 
Ctrl+F2 displays the print preview area on the Print tab in the Backstage view. 

F3 Displays the Paste Name dialog box. Available only if names have been defined in the 
workbook (Formulas tab, Defined Names group, Define Name). 

Shift+F3 displays the Insert Function dialog box. 
F4 Repeats the last command or action, if possible.  

When a cell reference or range is selected in a formula, F4 cycles through all the various 
combinations of absolute and relative references.  

Ctrl+F4 closes the selected workbook window. 

Alt+F4 closes Excel. 
F5 Displays the Go To dialog box. 

Ctrl+F5 restores the window size of the selected workbook window. 
F6 Switches between the worksheet, ribbon, task pane, and Zoom controls. In a worksheet that 

has been split (View menu, Manage This Window, Freeze Panes, Split Window 
command), F6 includes the split panes when switching between panes and the ribbon area.  

Shift+F6 switches between the worksheet, Zoom controls, task pane, and ribbon. 

Ctrl+F6 switches to the next workbook window when more than one workbook window is 
open. 

F7 Displays the Spelling dialog box to check spelling in the active worksheet or selected range. 

Ctrl+F7 performs the Move command on the workbook window when it is not maximized. 
Use the arrow keys to move the window, and when finished press Enter, or Esc to cancel. 

F8 Turns extend mode on or off. In extend mode, Extended Selection appears in the status 
line, and the arrow keys extend the selection. 

Shift+F8 enables you to add a nonadjacent cell or range to a selection of cells by using the 
arrow keys. 

Ctrl+F8 performs the Size command (on the Control menu for the workbook window) when 
a workbook is not maximized. 

Alt+F8 displays the Macro dialog box to create, run, edit, or delete a macro. 
F9 Calculates all worksheets in all open workbooks. 
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Key Description 
Shift+F9 calculates the active worksheet. 

Ctrl+Alt+F9 calculates all worksheets in all open workbooks, regardless of whether they 
have changed since the last calculation. 

Ctrl+Alt+Shift+F9 rechecks dependent formulas, and then calculates all cells in all open 
workbooks, including cells not marked as needing to be calculated. 

Ctrl+F9 minimizes a workbook window to an icon. 
F10 Turns key tips on or off. (Pressing Alt does the same thing.) 

Shift+F10 displays the shortcut menu for a selected item. 

Alt+Shift+F10 displays the menu or message for an Error Checking button.  

Ctrl+F10 maximizes or restores the selected workbook window. 
F11 Creates a chart of the data in the current range in a separate Chart sheet. 

Shift+F11 inserts a new worksheet. 

Alt+F11 opens the Microsoft Visual Basic For Applications Editor, in which you can create a 
macro by using Visual Basic for Applications (VBA). 

F12 Displays the Save As dialog box. 

 

Other useful shortcut keys 
Key Description 
Alt Displays the Key Tips (new shortcuts) on the ribbon.  

For example,  

Alt, W, P switches the worksheet to Page Layout view. 

Alt, W, L switches the worksheet to Normal view. 

Alt, W, I switches the worksheet to Page Break Preview view. 
Arrow 
Keys 

Move one cell up, down, left, or right in a worksheet.  

Ctrl+Arrow Key moves to the edge of the current data region in a worksheet. 
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Key Description 
Shift+Arrow Key extends the selection of cells by one cell. 

Ctrl+Shift+Arrow Key extends the selection of cells to the last nonblank cell in the 
same column or row as the active cell, or if the next cell is blank, extends the selection 
to the next nonblank cell. 

Left Arrow or Right Arrow selects the tab to the left or right when the ribbon is 
selected. When a submenu is open or selected, these arrow keys switch between the 
main menu and the submenu. When a ribbon tab is selected, these keys navigate the 
tab buttons. 

Down Arrow or Up Arrow selects the next or previous command when a menu or 
submenu is open. When a ribbon tab is selected, these keys navigate up or down the 
tab group. 

In a dialog box, arrow keys move between options in an open drop-down list, or 
between options in a group of options. 

Down Arrow or Alt+Down Arrow opens a selected drop-down list. 
Backspace Deletes one character to the left in the Formula Bar. 

Also clears the content of the active cell. 

In cell editing mode, it deletes the character to the left of the insertion point. 
Delete Removes the cell contents (data and formulas) from selected cells without affecting 

cell formats or comments.  

In cell editing mode, it deletes the character to the right of the insertion point.  
End End turns End mode on or off. In End mode, you can press an arrow key to move to 

the next nonblank cell in the same column or row as the active cell. End mode turns 
off automatically after pressing the arrow key. Make sure to press End again before 
pressing the next arrow key. End mode is shown in the status bar when it is on. 

If the cells are blank, pressing End followed by an arrow key moves to the last cell in 
the row or column.  

End also selects the last command on the menu when a menu or submenu is visible. 
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Key Description 
Ctrl+End moves to the last cell on a worksheet, to the lowest used row of the 
rightmost used column. If the cursor is in the formula bar, Ctrl+End moves the cursor 
to the end of the text. 

Ctrl+Shift+End extends the selection of cells to the last used cell on the worksheet 
(lower-right corner). If the cursor is in the formula bar, Ctrl+Shift+End selects all text 
in the formula bar from the cursor position to the end—this does not affect the 
height of the formula bar.  

Enter Completes a cell entry from the cell or the Formula Bar, and selects the cell below (by 
default). 

In a data form, it moves to the first field in the next record. 

Opens a selected menu (press F10 to activate the menu bar) or performs the action 
for a selected command. 

In a dialog box, it performs the action for the default command button in the dialog 
box (the button with the bold outline, often the OK button). 

Alt+Enter starts a new line in the same cell. 

Ctrl+Enter fills the selected cell range with the current entry. 

Shift+Enter completes a cell entry and selects the cell above. 
Esc Cancels an entry in the cell or Formula Bar.  

Closes an open menu or submenu, dialog box, or message window. 

It also closes full screen mode when this mode has been applied, and returns to 
normal screen mode to display the ribbon and status bar again. 

Home Moves to the beginning of a row in a worksheet. 

Moves to the cell in the upper-left corner of the window when Scroll Lock is turned 
on. 

Selects the first command on the menu when a menu or submenu is visible. 

Ctrl+Home moves to the beginning of a worksheet. 

Ctrl+Shift+Home extends the selection of cells to the beginning of the worksheet. 



 

40 
 

Key Description 
Page 
Down 

Moves one screen down in a worksheet.  

Alt+Page Down moves one screen to the right in a worksheet. 

Ctrl+Page Down moves to the next sheet in a workbook. 

Ctrl+Shift+Page Down selects the current and next sheet in a workbook. 
Page Up Moves one screen up in a worksheet. 

Alt+Page Up moves one screen to the left in a worksheet. 

Ctrl+Page Up moves to the previous sheet in a workbook. 

Ctrl+Shift+Page Up selects the current and previous sheet in a workbook. 
Spacebar In a dialog box, performs the action for the selected button, or selects or clears a 

check box. 

Ctrl+Spacebar selects an entire column in a worksheet. 

Shift+Spacebar selects an entire row in a worksheet. 

Ctrl+Shift+Spacebar selects the entire worksheet.  

 f the worksheet contains data, Ctrl+Shift+Spacebar selects the current region. Pressing 
Ctrl+Shift+Spacebar a second time selects the current region and its summary rows. 
Pressing Ctrl+Shift+Spacebar a third time selects the entire worksheet.  

 When an object is selected, Ctrl+Shift+Spacebar selects all objects on a worksheet. 

Alt+Spacebar displays the Control menu for the Excel window. 
Tab Moves one cell to the right in a worksheet. 

Moves between unlocked cells in a protected worksheet. 

Moves to the next option or option group in a dialog box. 

Shift+Tab moves to the previous cell in a worksheet or the previous option in a dialog 
box. 

Ctrl+Tab switches to the next tab in dialog box. 

Ctrl+Shift+Tab switches to the previous tab in a dialog box. 
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https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-
1798d9d5-842a-42b8-9c99-9b7213f0040f#top  

 

 

 

Insert and edit objects 
Insert an object 

1. Press Alt, N, J, and then J to open the Object dialog box. 

2. Do one of the following. 

o Press Down Arrow to select an object type, and then press Enter to create an object. 

o Press Ctrl+Tab to switch to the Create from File tab, press Tab, and then type the file 
name of the object that you want to insert or browse to the file. 

Edit an object 
1. With the cursor positioned to the left of the object in your document, select the object by 

pressing Shift+Right Arrow. 

2. Press Shift+F10. 

3. Press the Tab key to get to Object name, press Enter, and then press Enter again. 

Insert SmartArt graphics 
1. Press and release Alt, N, and then M to select SmartArt.  

2. Press the arrow keys to select the type of graphic that you want. 

3. Press Tab, and then press the arrow keys to select the graphic that you want to insert. 

4. Press Enter. 

Insert WordArt 
1. Press and release Alt, N, and then W to select WordArt.  

2. Press the arrow keys to select the WordArt style that you want, and then press Enter. 

3. Type the text that you want. 

4. Press Esc to select the WordArt object, and then use the arrow keys to move the object. 

5. Press Esc again to return to return to the document. 

Mail merge and fields 
Note: You must press Alt+M, or click Mailings, to use these keyboard shortcuts. 

https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9c99-9b7213f0040f#top
https://support.office.com/en-us/article/Excel-keyboard-shortcuts-and-function-keys-for-Windows-1798d9d5-842a-42b8-9c99-9b7213f0040f#top
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Perform a mail merge 
To do this  Press  
Preview a mail merge. Alt+Shift+K 
Merge a document. Alt+Shift+N 
Print the merged document. Alt+Shift+M 
Edit a mail-merge data document. Alt+Shift+E 
Insert a merge field. Alt+Shift+F 

Work with fields 
To do this  Press  
Insert a DATE field. Alt+Shift+D 
Insert a LISTNUM field. Alt+Ctrl+L 
Insert a Page field. Alt+Shift+P 
Insert a TIME field. Alt+Shift+T 
Insert an empty field. Ctrl+F9 
Update linked information in a Microsoft Word 
source document. 

Ctrl+Shift+F7 

Update selected fields. F9 
Unlink a field. Ctrl+Shift+F9 
Switch between a selected field code and its 
result. 

Shift+F9 

Switch between all field codes and their results. Alt+F9 
Run GOTOBUTTON or MACROBUTTON from the 
field that displays the field results. 

Alt+Shift+F9 

Go to the next field. F11 
Go to the previous field. Shift+F11 
Lock a field. Ctrl+F11 
Unlock a field. Ctrl+Shift+F11 

Language Bar 
Set proofing language 
Every document has a default language, typically the same default language as your computer's 
operating system. But If your document also contains words or phrases in a different language, it's a 
good idea to set the proofing language for those words. This not only makes it possible to check spelling 
and grammar for those phrases, it makes it possible for assistive technologies like screen readers to 
handle them.  

To do this Press 
Open the Set Proofing Language dialog box Alt+R, U, L 
Review list of proofing languages Down Arrow 
Set default languages Alt+R, L 

Turn on East Asian Input Method Editors 

To do this Press 
Turn Japanese Input Method Editor (IME) on 101 
keyboard on or off. 

Alt+~ 

Turn Korean Input Method Editor (IME) on 101 
keyboard on or off. 

Right Alt 



 

43 
 

Turn Chinese Input Method Editor (IME) on 101 
keyboard on or off. 

Ctrl+Spacebar 

Function key reference 
Function keys 

To do this  Press  
Get Help or visit Office.com. F1 
Move text or graphics. F2 
Repeat the last action. F4 
Choose the Go To command (Home tab). F5 
Go to the next pane or frame. F6 
Choose the Spelling command (Review tab). F7 
Extend a selection. F8 
Update the selected fields. F9 
Show KeyTips. F10 
Go to the next field. F11 
Choose the Save As command. F12 

Shift+Function keys 
To do this  Press  
Start context-sensitive Help or reveal formatting. Shift+F1 
Copy text. Shift+F2 
Change the case of letters. Shift+F3 
Repeat a Find or Go To action. Shift+F4 
Move to the last change. Shift+F5 
Go to the previous pane or frame (after pressing 
F6). 

Shift+F6 

Choose the Thesaurus command (Review tab, 
Proofing group). 

Shift+F7 

Reduce the size of a selection. Shift+F8 
Switch between a field code and its result. Shift+F9 
Display a shortcut menu. Shift+F10 
Go to the previous field. Shift+F11 
Choose the Save command. Shift+F12 

Ctrl+Function keys 
To do this  Press  
Expand or collapse the ribbon. Ctrl+F1 
Choose the Print Preview command. Ctrl+F2 
Cut to the Spike. Ctrl+F3 
Close the window. Ctrl+F4 
Go to the next window. Ctrl+F6 
Insert an empty field. Ctrl+F9 
Maximize the document window. Ctrl+F10 
Lock a field. Ctrl+F11 
Choose the Open command. Ctrl+F12 
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Ctrl+Shift+Function keys 
To do this  Press  
Insert the contents of the Spike. Ctrl+Shift+F3 
Edit a bookmark. Ctrl+Shift+F5 
Go to the previous window. Ctrl+Shift+F6 
Update linked information in a Word source 
document. 

Ctrl+Shift+F7 

Extend a selection or block. Ctrl+Shift+F8, and then press an arrow key 
Unlink a field. Ctrl+Shift+F9 
Unlock a field. Ctrl+Shift+F11 
Choose the Print command. Ctrl+Shift+F12 

Alt+Function keys 
To do this  Press  
Go to the next field. Alt+F1 
Create a new Building Block. Alt+F3 
Exit Word. Alt+F4 
Restore the program window size. Alt+F5 
Move from an open dialog box back to the 
document, for dialog boxes that support this 
behavior. 

Alt+F6 

Find the next misspelling or grammatical error.  Alt+F7 
Run a macro. Alt+F8 
Switch between all field codes and their results. Alt+F9 
Display the Selection task pane. Alt+F10 
Display Microsoft Visual Basic code. Alt+F11 

Alt+Shift+Function keys 
To do this  Press  
Go to the previous field. Alt+Shift+F1 
Choose the Save command. Alt+Shift+F2 
Run GOTOBUTTON or MACROBUTTON from the 
field that displays the field results. 

Alt+Shift+F9 

Display a menu or message for an available 
action. 

Alt+Shift+F10 

Choose Table of Contents button in the Table of 
Contents container when the container is active. 

Alt+Shift+F12 

Ctrl+Alt+Function keys 
To do this  Press  
Display Microsoft System Information. Ctrl+Alt+F1 
Choose the Open command. Ctrl+Alt+F2 

https://support.office.com/en-us/article/Keyboard-shortcuts-for-Microsoft-Word-on-Windows-
95ef89dd-7142-4b50-afb2-f762f663ceb2  

How to Use Microsoft Office PowerPoint 
A brief overview of PowerPoint. 

https://support.office.com/en-us/article/Keyboard-shortcuts-for-Microsoft-Word-on-Windows-95ef89dd-7142-4b50-afb2-f762f663ceb2
https://support.office.com/en-us/article/Keyboard-shortcuts-for-Microsoft-Word-on-Windows-95ef89dd-7142-4b50-afb2-f762f663ceb2
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For more information go to: https://support.office.com/en-us/article/PowerPoint-training-40e8c930-
cb0b-40d8-82c4-bd53d3398787  

How to Use Microsoft Office OneNote 
A brief overview of OneNote. 

For more information go to: https://support.office.com/en-us/article/OneNote-training-1c983b65-42f6-
42c1-ab61-235aae5d0115  

How to Use Microsoft Office Access 
A brief overview of Access. 

For more information go to: https://support.office.com/en-us/article/Access-training-a5ffb1ef-4cc4-
4d79-a862-e2dda6ef38e6  

How to Use Microsoft Office Publisher 
A brief overview of Publisher. 

For more information go to: https://support.office.com/en-us/article/Publisher-training-5ce4abaa-3557-
4115-84c0-3232a5d59939  

 

  

https://support.office.com/en-us/article/PowerPoint-training-40e8c930-cb0b-40d8-82c4-bd53d3398787
https://support.office.com/en-us/article/PowerPoint-training-40e8c930-cb0b-40d8-82c4-bd53d3398787
https://support.office.com/en-us/article/OneNote-training-1c983b65-42f6-42c1-ab61-235aae5d0115
https://support.office.com/en-us/article/OneNote-training-1c983b65-42f6-42c1-ab61-235aae5d0115
https://support.office.com/en-us/article/Access-training-a5ffb1ef-4cc4-4d79-a862-e2dda6ef38e6
https://support.office.com/en-us/article/Access-training-a5ffb1ef-4cc4-4d79-a862-e2dda6ef38e6
https://support.office.com/en-us/article/Publisher-training-5ce4abaa-3557-4115-84c0-3232a5d59939
https://support.office.com/en-us/article/Publisher-training-5ce4abaa-3557-4115-84c0-3232a5d59939
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How to Use Microsoft Office Outlook 
A brief overview of Outlook. 

For more information go to: https://support.office.com/en-us/article/Outlook-training-8a5b816d-9052-
4190-a5eb-494512343cca  

Home 
New 

- New Email (Create a new email) 
- New Items (Create new appointment, meeting etc) 

Delete 
- Ignore (moves this and future responses to the junk folder) 
- Clean Up (cleans up folders, conversations etc.) 
- Junk (send email to junk) 
- Delete (delete the message) 

Respond 
- Reply (reply to the person who sent the message) 
- Reply All (Reply to everyone in the chat) 
- Forward (Forward the email to someone you specify) 
- Meeting (Respond by setting up a meeting) 
- IM (Reply with an instant message to one or all) 
- More (forward all of the messages or call the person sending it) 

Quick Steps 
- Job (moves it to the folder called Job, this folder will change depending on what you have your 

folders name set to) 
- Team Email (like a custom group, sends email to set group of people without manually adding 

them every time) 
- Reply & Delete (Reply’s to sender and deletes the original email) 
- To Manager (Forward to your manager, you will have to set it up with the appropriate email) 
- Done (Moves the email to a folder you specify and marks it as read) 
- Create New (allows you to create your own quick step) 
- Down arrow (gives you the option to create new quick steps and manage the ones you have 

Move 
- Move (gives you options of folders to send it to) 
- Rules (Create rules to alert you when certain conditions apply) 
- OneNote (send the message to OneNote) 

 

Tags 
- Assign Policy(create Policy for automatically sorting mail into folders for you) 
- Unread/Read (Mark it or unmark it as red) 
- Categorize (color code it) 

https://support.office.com/en-us/article/Outlook-training-8a5b816d-9052-4190-a5eb-494512343cca
https://support.office.com/en-us/article/Outlook-training-8a5b816d-9052-4190-a5eb-494512343cca
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- Follow Up (flags it to remind you to tend to it later) 

Find 
- Search (allows you to search for specific people and pull up information on them, in that popup it 

willallow you to message, set up a meeting etc.) 
- Address Book (Search your Address Book for specific people, pulls up their information) 
- Filter Email (sort by date, category, etc.) 

Add ins  
- Store (directs you to the store for add-ins) 

 

Adobe send & Track 
- My Account (directs you to your account, displays your add-ins etc.) 

 

Send/Received 
Send & Receive 

- Send/Receive All Folders () 
- Update Folder () 
- Send All (send all unsent emails) 
- Send/Receive Groups () 

 
Download 

- Show Progress (shows your sent emails and if they have been received) 
- Cancel All (Cancels all pending sent receive  email requests) 

Server 
- Download Headers () 
- Mark to download () 
- Unmark to Download () 
- Process Marked Headers () 

 

Preferences 
- Download Preferences (gives options for downloading mail to work offline) 
- Work Offline (disconnect form the server to not receive new mail) 

 

Folder 
New 

- New Folder (creates a new folder to sort your mail into) 
- New Search Folder (a folder which automatically sorts through specific criteria) 
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Actions 
- Rename Folder (allows you to rename the selected folder) 
- Copy Folder (copy the folder to a new location) 
- Move Folder (move the folder to a new location) 
- Delete Folder (removes the folder) 
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Clean Up 
- Mark all as Read (marks all the emails in that folder as read) 
- Run Rules Now (apply all the rules you have in your mailbox) 
- Show All Folders A-Z (displays folders alphabetically) 
- Clean up Folder (removes redundant messages to save space) 
- Delete All (deletes all items in a specific folder) 
- Recover Deleted Items (recovers deleted emails) 

Favorites 
- Show in Favorites 

() 

Online View 
49View on Server button (view archived emails, you set when they are archived using Policy)button 

(view archived emails, you set when they are archived using Policy)button (view archived emails, 
you set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy) 

Properties 
- Policy (sets when emails are sent to the online archive can be viewed using the View on Server 

button (view archived emails, you set when they are archived using Policy)button (view archived 
emails, you set when they are archived using Policy)button (view archived emails, you set when 
they are archived using Policy)button (view archived emails, you set when they are archived using 
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Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button (view archived emails, you set when they are 
archived using Policy)button (view archived emails, you set when they are archived using 
Policy)button (view archived emails, you set when they are archived using Policy)button (view 
archived emails, you set when they are archived using Policy)button (view archived emails, you 
set when they are archived using Policy)button 

- Folder Permissions (edit sharing permissions) 
- Folder Properties (change the name, what it displays, permissions etc.) 

View 
Current View 

- Change View (manage if you view one message or multiple) 
- View Settings (advanced settings, more details to change) 
- Reset View (revert to default view settings) 

 

Messages 
- Show as Conversations (messages are arranged by conversation) 
- Conversation Settings (change how the conversation is displayed) 
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Arrangement 
- Message preview (allows you to preview messages before clicking on them, up to 3 lines of text) 
- Date, From, To, categories, Flag: Start Date, Flag: Due Date, Size, Subject (group by and sort 

options) 
- Reverse Sort (reverse the settings for how you are viewing messages) 
- Add Columns (choose more fields to display) 
- Expand/Collapse (expands or collapses groups) 

Layout 
- Folder Pane (shows more or less of folder column) 
- Reading Pane (shows more or less of folder column) 
- To-Do Bar 

People Pane 
- People Pane 

Window 
- Reminders Window 
- Open in New Window 
- Close All Items 

 

Adobe PDF 
Convert 

- Selected Messages 
- Selected Folders 

Preferences 
- Change Conversion Settings 

Archive 
- Set up automatic Archival  

Recall email:  
- Open the message you want to recall 
- Click actions: select Recall This Message 
- Pick if you want to replace the message or just delete it 

Recall-or-replace-an-email-message-that-you-sent  

 

  

https://support.office.com/en-us/article/Recall-or-replace-an-email-message-that-you-sent-35027f88-d655-4554-b4f8-6c0729a723a0?ui=en-US&rs=en-US&ad=US


 

52 
 

Set up automatic reply:  
• Click File 
• Click Automatic Replies 
• Select: Send Automatic Replies 

- You can choose to have it send all the time or for a certain duration. 
- Insert your text into the white box 

how-to-use-the-out-of-office-assistant-in-outlook  

Set up meeting:  
- In the home tab click New Items 
- Click Meeting 
- Type in the names you want to be in the meeting 

- Under suggested times on the bottom right you can view conflicts 
- Fill out the appropriate fields  

- Select a Room and press OK 
- Click Send 

Schedule-a-meeting-with-other-people  

How to use the schedule assistant 
- Click Scheduling Assistant while setting up the meeting 
- Blocks filled with color indicate that that person is not available, the top column displays 

everyone’s availability for easy reference. 
- Click on the Appointment button to get back to typing the meeting up. 
- Click send when you have completed setting it up 

Keyboard shortcuts for Microsoft 
Outlook 2013 and 2016 

 

This reference article provides a comprehensive list of all keyboard shortcuts for Microsoft Outlook 2013 
and 2016 (desktop version). Shortcuts are grouped by functionality; for example, you’ll find shortcuts for 
moving around in Outlook under “Navigation”. As you might guess, you’ll find some shortcuts listed 
more than once. 

To find links to keyboard shortcuts for other Microsoft products, go to Office Accessibility Center. 

 

Note:  

• Keys that should be pressed at the same time are joined with a plus sign (+). Keys that you 
should press in sequence are joined by a comma (,). Thus, the keyboard shortcut Alt+H, M+R 

https://support.microsoft.com/en-us/help/290846/how-to-use-the-out-of-office-assistant-in-outlook
https://support.office.com/en-us/article/Schedule-a-meeting-with-other-people-5c9877bc-ab91-4a7c-99fb-b0b68d7ea94f
http://aka.ms/officeaccessibility
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means press Alt and H together to open the Home tab on the ribbon, and then press letters M 
and R together to open a new Meeting Request. 

Frequently used shortcuts 
The following shortcuts are the most frequently used in Outlook 2013 and 2016. 

To do this Press 
Close Alt+F, then X 
Go to Home tab Alt+H 
New mail message Ctrl+N 
Send Alt+S 
Insert file in a message Alt+H, then AF 
Zoom Ctrl+Plus(+), Ctrl+Minus(-) 
Delete selected item Ctrl+D 
Go to Search box F3 or Ctrl+E 
Reply Ctrl+R 
Forward Ctrl+F 
Reply All Ctrl+Shift+R 
Start Send/Receive for folders and groups F9 
Go to Calendar Ctrl+2 
Create appointment Alt+H, then N1 
Move to folder Alt+H, then MV. Use Down Arrow to select folder. 
Attachment Save As From the message that contains the attachment, 

press Alt+JA, then AA. 
 

Work in Outlook 
Move around in Inbox and between Outlook views 

To do this  Press  
Go to the Search box. F3 or Ctrl+E 
In the Reading Pane, go to the previous message. Alt+Up Arrow, or 

Ctrl+Comma, or 
Alt+Page Up 

In the Reading Pane, page down through text. Spacebar 
In the Reading Pane, page up through text. Shift+Spacebar 
Move between regions in Outlook, such as the Folder Pane, the main 
Outlook window, the Reading Pane, and the To-Do Bar. 

Ctrl+Shift+Tab, or 
Shift+Tab 

Move between regions in Outlook, such as the Outlook window, the 
smaller panes in the Folder Pane, the Reading Pane, and the sections in 
the To-Do Bar. 

Tab 

Move between regions in Outlook, such as the Outlook window, the 
smaller panes in the Folder Pane, the Reading Pane, and the sections in 
the To-Do Bar, and show the access keys in the Outlook ribbon. 

F6 

Move around message header lines in the Folder Pane or an open 
message. 

Ctrl+Tab 
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To do this  Press  
Move around within the Folder Pane. Arrow keys 
Go to a different folder. Ctrl+Y 
Collapse or expand a group in the email message list. Left Arrow or Right 

Arrow, respectively 

Switch to a different Outlook view (Mail, Calendar, Contacts, and so on) 
To do this Press 
Switch to Mail. Ctrl+1 
Switch to Calendar. Ctrl+2 
Switch to Contacts. Ctrl+3 
Switch to Tasks. Ctrl+4 
Switch to Notes. Ctrl+5 
Switch to Folder List in Folder Pane. Ctrl+6 
Switch to Shortcuts. Ctrl+7 
Switch to next message (with message open). Ctrl+Period 
Switch to previous message (with message open). Ctrl+Comma 
Go back to previous view in main Outlook window. Alt+B or Alt+Left Arrow 
Go forward to next view in main Outlook window. Alt+Right Arrow 
Select the InfoBar and, if available, show the menu of commands. Ctrl+Shift+W 

Search in any Outlook view (Mail, Calendar, etc) 
To do this  Press  
Go to Search box. F3 or Ctrl+E 
Clear the search results. Esc 
Expand the search to include All Mail Items, All Calendar Items, or All 
Contact Items, depending on the module you are in. 

Ctrl+Alt+A 

Use Advanced Find. Ctrl+Shift+F 
Create a Search Folder. Ctrl+Shift+P 
Search for text within an open item. F4 
Find and replace text and symbols in the Reading Pane. Ctrl+H 
Expand search to include items from the current folder. Ctrl+Alt+K 
Expand search to include subfolders. Ctrl+Alt+Z 

Format text 
To do this  Press  
Cut. Ctrl+X or Shift+Delete 
Copy. Ctrl+C or Ctrl+Insert 
Paste. Ctrl+V or Shift+Insert 
Undo. Ctrl+Z or Alt+Backspace 
Bold. Ctrl+B 
Italic. Ctrl+I 
Underline Ctrl+U 
Add bullets. Ctrl+Shift+L 
Display the Format menu. Alt+O 
Display the Font dialog box. Ctrl+Shift+P 
Switch case (with text selected). Shift+F3 
Format letters as small capitals. Ctrl+Shift+K 
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To do this  Press  
Increase indent. Ctrl+T 
Decrease indent. Ctrl+Shift+T 
Left align text. Ctrl+L 
Center text. Ctrl+E 
Right align text. Ctrl+R 
Stretch a paragraph to fit between the 
margins. 

Ctrl+Shift+J  

Increase font size. Ctrl+] or Ctrl+Shift+> 
Decrease font size. Ctrl+[ or Ctrl+Shift+< 
Clear formatting. Ctrl+Shift+Z or Ctrl+Spacebar 
Delete the next word. Ctrl+Shift+H 
Apply paragraph or heading styles. Ctrl+Shift+S 
Create a hanging indent. Ctrl+T 
Insert a hyperlink. Ctrl+K 
Reduce a hanging indent. Ctrl+Shift+T 
Remove paragraph formatting. Ctrl+Q 

Print  
To do this  Press  
Open Print tab in Backstage view. Press Alt+F, and then press P 
To print an item from an open 
window. 

Alt+F, press P, and then press F and press 1 

Open Page Setup from Print 
Preview. 

Alt+S or Alt+U 

To select a printer from Print 
Preview. 

Alt+F, press P, and then press I 

To Define Print Styles. Alt+F, press P, and then press L 
To open Print Options. Alt+F, press P, and then press R 

Add or edit links 
To do this  Press  
Edit a URL in the body of an 
item. 

Hold down Ctrl and click the mouse button. 

Insert a hyperlink. Ctrl+K 

Create an item or file 
To do this  Press  
Create an appointment. Ctrl+Shift+A 
Create a contact. Ctrl+Shift+C 
Create a contact group. Ctrl+Shift+L 
Create a fax. Ctrl+Shift+X 
Create a folder. Ctrl+Shift+E 
Create a meeting request. Ctrl+Shift+Q 
Create a message. Ctrl+Shift+M 
Create a note. Ctrl+Shift+N 
Create a Microsoft Office 
document. 

Ctrl+Shift+H 
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To do this  Press  
Post to this folder. Ctrl+Shift+S 
Post a reply in this folder. Ctrl+T 
Create a Search Folder. Ctrl+Shift+P 
Create a task. Ctrl+Shift+K 
Create a task request. Ctrl+Shift+U 

Mail 
Frequently used mail shortcuts 

To do this  Press  
Switch to Mail. Ctrl+1 
Send. Alt+S or Ctrl+Enter 
Reply to a message. Ctrl+R 
Reply all to a message. Ctrl+Shift+R 
Forward a message. Ctrl+F 
Create a message (when in Mail). Ctrl+N 
Create a message (from any Outlook 
view). 

Ctrl+Shift+M 

Open a received message. Ctrl+O 
Mark as read. Ctrl+Q 
Mark as unread. Ctrl+U 
Go to the previous message. Up Arrow 
Go to the next message. Down Arrow 

Other mail shortcuts 
To do this Press 
Add a Quick Flag to an unopened 
message. 

Insert 

Apply Normal style. Ctrl+Shift+N 
Check for new messages. Ctrl+M or F9 
Check names. Ctrl+K 
Choose the account from which to send 
a message. 

Ctrl+Tab (with focus on the To box), and then Tab to the 
Accounts button 

Clear Mark for Download. Ctrl+Alt+U 
Create a multimedia message Ctrl+Shift+U 
Delete and Ignore a Conversation. Ctrl+Shift+D 
Display blocked external content (in a 
message). 

Ctrl+Shift+I 

Display Send/Receive progress. Ctrl+B (when a Send/Receive is in progress) 
Display the Flag for Follow Up dialog 
box. 

Ctrl+Shift+G 

Find next. Shift+F4 
Find or replace. F4 
Forward as attachment. Ctrl+Alt+F 
Mark a message as not junk. Ctrl+ Alt+J 
Mark for Download. Ctrl+Alt+M 
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To do this Press 
Open the Address Book. Ctrl+Shift+B 
Open the Mail Tip in the selected 
message. 

Ctrl+Shift+W 

Post to a folder. Ctrl+ Shift+S 
Print. Ctrl+P 
Reply with meeting request. Ctrl+Alt+R 
Show the properties for the selected 
item. 

Alt+Enter 

Calendar 
Frequently used calendar shortcuts 

To do this  Press  
Switch to Calendar Ctrl+2 
Create an appointment (when in Calendar). Ctrl+N 
Create an appointment (in any Outlook view). Ctrl+Shift+A 
Create a meeting request. Ctrl+Shift+Q 
Forward an appointment or meeting. Ctrl+F 
Reply to a meeting request with a message. Ctrl+R 
Reply All to a meeting request with a message. Ctrl+Shift+R 
Go to a date. Ctrl+G 

Other calendar shortcuts 
To do this Press 
Show 1 day in the calendar. Alt+1 
Show 2 days in the calendar. Alt+2 
Show 3 days in the calendar. Alt+3 
Show 4 days in the calendar. Alt+4 
Show 5 days in the calendar. Alt+5 
Show 6 days in the calendar. Alt+6 
Show 7 days in the calendar. Alt+7 
Show 8 days in the calendar. Alt+8 
Show 9 days in the calendar. Alt+9 
Show 10 days in the calendar. Alt+0 
Switch to Month view. Alt+= or Ctrl+Alt+4 
Switch to Full Week view. Alt+Minus Sign or Ctrl+Alt+3 
Switch to Work Week view. Ctrl+Alt+2 
Go to the next day. Ctrl+Right Arrow 
Go to the next week. Alt+Down Arrow  
Go to the next month. Alt+Page Down  
Go to the previous day. Ctrl+Left Arrow 
Go to the previous week. Alt+Up Arrow  
Go to the previous month. Alt+Page Up 
Go to the start of the week. Alt+Home 
Go to the end of the week. Alt+End 
Go to previous appointment. Ctrl+Comma or Ctrl+Shift+Comma 
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To do this Press 
Go to next appointment. Ctrl+Period or Ctrl+Shift+Period 
Set up recurrence for an open appointment or 
meeting. 

Ctrl+G 

See also under Views: Calendar Day/Week/Month view, and Date Navigator. 

Contacts 
To do this  Press  
Find a contact. F11 
Dial a new call. Ctrl+Shift+D 
Find a contact or other item (Search). F3 or Ctrl+E 
Enter a name in the Search Address Books box. F11 
In Table or List view of contacts, go to first contact that starts with a specific 
letter. 

Shift+letter 

Select all contacts. Ctrl+A 
Create a message with selected contact as subject. Ctrl+F 
Create a contact (when in Contacts). Ctrl+N 
Create a contact (from any Outlook view). Ctrl+Shift+C 
Open a contact form for the selected contact. Ctrl+O 
Create a contact group. Ctrl+Shift+L 
Print. Ctrl+P 
Update a list of contact group members. F5 
Go to a different folder. Ctrl+Y 
Open the Address Book. Ctrl+Shift+B 
Use Advanced Find. Ctrl+Shift+F 
In an open contact, open the next contact listed. Ctrl+Shift+Period 
Close a contact. ESC 
Send a fax to the selected contact. Ctrl+Shift+X 
Open the Check Address dialog box. Alt+D 
In a contact form, under Internet, display the Email 1 information. Alt+Shift+1 
In a contact form, under Internet, display the Email 2 information. Alt+Shift+2 
In a contact form, under Internet, display the Email 3 information. Alt+Shift+3 

Electronic Business Cards  
Frequently used shortcuts for Electronic Business Cards 

To do this  Press  
Open the Add list. Alt+A 
Select text in Label box when the field with a label assigned is 
selected. 

Alt+B 

Open the Add Card Picture dialog box. Alt+C 
Place cursor at beginning of Edit box. Alt+E 
Select the Fields box. Alt+F 
Select the Image Align drop-down list. Alt+G 
Select color palette for background. Alt+K, then Enter 
Select Layout drop-down list. Alt+L 
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To do this  Press  
Remove a selected field from the Fields box. Alt+R 

Select items in Business Cards view 
To do this  Press  
Select a specific card in the list. One or more letters of the name that the card is filed 

under or the name of the field that you are sorting by 
Select the previous card. Up Arrow 
Select the next card. Down Arrow 
Select the first card in the list. Home 
Select the last card in the list. End 
Select the first card on the current page. Page Up 
Select the first card on the next page. Page Down 
Select the closest card in the next column. Right Arrow 
Select the closest card in the previous 
column. 

Left Arrow 

Select or cancel selection of the active card. Ctrl+Spacebar 
Extend the selection to the previous card 
and cancel selection of cards after the 
starting point. 

Shift+Up Arrow 

Extend the selection to the next card and 
cancel selection of cards before the starting 
point. 

Shift+Down Arrow 

Extend the selection to the previous card, 
regardless of the starting point. 

Ctrl+Shift+Up Arrow 

Extend the selection to the next card, 
regardless of the starting point. 

Ctrl+Shift+Down Arrow 

Extend the selection to the first card in the 
list. 

Shift+Home 

Extend the selection to the last card in the 
list. 

Shift+End 

Extend the selection to the first card on the 
previous page. 

Shift+Page Up 

Extend the selection to the last card on the 
last page. 

Shift+Page Down 

Move between fields in an open card 
To use the following keys, make sure a field in a card is selected. To select a field when a card is selected, 
click the field. 

To do this  Press  
Move to the next field and control. Tab 
Move to the previous field and 
control. 

Shift+Tab 

Close the active card. Enter 
Move between characters in a field 
To use the following keys, make sure a field in a card is selected. To select a field when a card is selected, 
click the field. 
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To do this  Press  
Add a line in a multiline field. Enter 
Move to the beginning of a line. Home 
Move to the end of a line. End 
Move to the beginning of a multiline field. Page Up 
Move to the end of a multiline field. Page Down 
Move to the previous line in a multiline 
field. 

Up Arrow 

Move to the next line in a multiline field. Down Arrow 
Move to the previous character in a field. Left Arrow 
Move to the next character in a field. Right Arrow 

Tasks 
Frequently used shortcuts for Tasks 

To do this  Press  
Accept a task request. Alt+C 
Decline a task request. Alt+D 
Find a task or other item. Ctrl+E 
Open the Go to Folder dialog box. Ctrl+Y 
Create a task (when in Tasks). Ctrl+N 
Create a task (from any Outlook view). Ctrl+Shift+K 
Open selected item. Ctrl+O 
Print selected item. Ctrl+P 
Select all items. Ctrl+A 
Delete selected item. Ctrl+D 
Forward a task as an attachment. Ctrl+F 
Create a task request. Ctrl+Shift+Alt+U 
Switch between the Folder Pane, Tasks list, and To-Do 
Bar. 

Tab or Shift+Tab 

Undo last action. Ctrl+Z 
Flag an item or mark complete. Insert 

Work with Task items in Timeline view 
When an item is selected 

To do this  Press  
Select the previous item. Left Arrow 
Select the next item. Right Arrow 
Select several adjacent items. Shift+Left Arrow or Shift+Right 

Arrow 
Select several nonadjacent items. Ctrl+Left Arrow+Spacebar or 

Ctrl+Right Arrow+Spacebar 
Open the selected items. Enter 
Select the first item on the timeline (if items are not grouped) 
or the first item in the group. 

Home 

Select the last item on the timeline (if items are not grouped) 
or the last item in the group. 

End 
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To do this  Press  
Display (without selecting) the first item on the timeline (if 
items are not grouped) or the first item in the group. 

Ctrl+Home 

Display (without selecting) the last item on the timeline (if 
items are not grouped) or the last item in the group. 

Ctrl+End 

When a group is selected 
To do this  Press  
Expand the group. Enter or Right 

Arrow 
Collapse the group. Enter or Left 

Arrow 
Select the previous group. Up Arrow 
Select the next group. Down Arrow 
Select the first group on the timeline. Home 
Select the last group on the timeline. End 
Select the first item on screen in an expanded group or the first item off screen 
to the right. 

Right Arrow 

When a unit of time on the time scale for days is selected 
To do this  Press  
Move back in increments of time that are the same as those shown on the time 
scale. 

Left Arrow 

Move forward in increments of time that are the same as those shown on the time 
scale. 

Right Arrow 

Switch between active view, To-Do Bar, Search and back to active view. Tab and 
Shift+Tab 

Groups 
Work with groups 

To do this  Press  
Expand a single selected group. Right 

Arrow 
Collapse a single selected group. Left Arrow 
Select the previous group. Up Arrow 
Select the next group. Down 

Arrow 
Select the first group. Home 
Select the last group. End 
Select the first item on screen in an expanded group or the first item off screen to the 
right. 

Right 
Arrow 

Send/Receive folders and groups 
To do this  Press  
Start a send/receive for all defined Send/Receive groups with Include this group in 
Send/Receive (F9) selected. This can include headers, full items, specified folders, items 
less than a specific size, or any combination that you define. 

F9 
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To do this  Press  
Start a send/receive for the current folder, retrieving full items (header, item, and any 
attachments). 

Shift+F9 

Start a send/receive. Ctrl+M 
Define Send/Receive groups. Ctrl+Alt+S 

Views in Outlook 
Table view 

To do this  Press  
Open an item. Enter 
Select all items. Ctrl+A 
Go to the item at the bottom of the screen. Page Down 
Go to the item at the top of the screen. Page Up 
Extend or reduce the selected items by one item. Shift+Up Arrow or Shift+Down Arrow, 

respectively 
Go to the next or previous item without extending the 
selection. 

Ctrl+Up Arrow or Ctrl+Down Arrow, 
respectively 

Select or cancel selection of the active item. Ctrl+Spacebar 

Calendar views 
To do this  Press  
View from 1 through 9 days. Alt+key for number of days 
View 10 days. Alt+0 (zero) 
Switch to weeks. Alt+Minus Sign 
Switch to months. Alt+= 
Move between Calendar, TaskPad, and the Folder 
List. 

Ctrl+Tab or F6 

Select the previous appointment. Shift+Tab 
Go to the previous day. Left Arrow 
Go to the next day. Right Arrow 
Go to the same day in the next week. Alt+Down Arrow 
Go to the same day in the previous week. Alt+Up Arrow 

Day view 
To do this  Press  
Select the time that begins your work 
day. 

HOME 

Select the time that ends your work 
day. 

END 

Select the previous block of time. Up Arrow 
Select the next block of time. Down Arrow 
Select the block of time at the top of 
the screen. 

Page Up 

Select the block of time at the bottom 
of the screen. 

Page Down 

Extend or reduce the selected time. Shift+Up Arrow or Shift+Down Arrow, respectively 
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To do this  Press  
Move an appointment up or down. With the cursor in the appointment, Alt+Up Arrow or 

Alt+Down Arrow, respectively 
Change an appointment's start or end 
time. 

With the cursor in the appointment, Alt+Shift+Up Arrow or 
Alt+Shift+Down Arrow, respectively 

Move selected item to the same day 
in the next week. 

Alt+Down Arrow 

Move selected item to the same day 
in the previous week. 

Alt+Up Arrow 

Week view 
To do this  Press  
Go to the start of work hours 
for the selected day. 

Home 

Go to the end of work hours for 
the selected day. 

End 

Go up one page view in the 
selected day. 

Page Up 

Go down one page view in the 
selected day. 

Page Down 

Change the duration of the 
selected block of time. 

Shift+Left Arrow, Shift+Right Arrow, Shift+Up Arrow, or Shift+Down 
Arrow; or Shift+Home or Shift+End 

Month view 
To do this  Press  
Go to the first day of the week. Home 
Go to the same day of the week in the previous 
page. 

Page Up 

Go to the same day of the week in the next page. Page Down 
Date Navigator 

To do this  Press  
Go to the first day of the current week. Alt+Home 
Go to the last day of the current week. Alt+End 
Go to the same day in the previous 
week. 

Alt+Up Arrow 

Go to the same day in the next week. Alt+Down Arrow 
https://support.office.com/en-us/article/Keyboard-shortcuts-for-Outlook-3cdeb221-7ae5-4c1d-8c1d-
9e63216c1efd?ui=en-US&rs=en-US&ad=US  

 

 

  

https://support.office.com/en-us/article/Keyboard-shortcuts-for-Outlook-3cdeb221-7ae5-4c1d-8c1d-9e63216c1efd?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/Keyboard-shortcuts-for-Outlook-3cdeb221-7ae5-4c1d-8c1d-9e63216c1efd?ui=en-US&rs=en-US&ad=US
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How to Use Microsoft Office OneDrive for Business 
A brief overview of Outlook. 

For more information go to:  

https://support.office.com/en-us/article/OneDrive-training-1f608184-b7e6-43ca-8753-
2ff679203132#ID0ECBAAA=OneDrive_for_Business  

Logging into OneDrive 

Accessing OneDrive 

i This is an Endnote: it appears at the bottom of the document  
                                                           

https://support.office.com/en-us/article/OneDrive-training-1f608184-b7e6-43ca-8753-2ff679203132#ID0ECBAAA=OneDrive_for_Business
https://support.office.com/en-us/article/OneDrive-training-1f608184-b7e6-43ca-8753-2ff679203132#ID0ECBAAA=OneDrive_for_Business
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